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QUICK START OVERVIEW 

Now that you have installed TTS or logged in to the portal (cloud), you are ready to begin using the 

system. This brief Quick Start Overview and the following User’s Manual provide the general 

information needed to begin entering data into the system and using TTS for the first time.  

INSTALLATION 

STEP 1  

Follow the instructions to install the system using the “PC Installation Guide” provided to you in your 

Order Acknowledgement email. You can install the system with an Access database (built-in to the 

system) or with a Sequel Server database (must be managed separately). If you purchased or are 

testing out a Cloud-Hosted system, please follow the directions you were given to download the RDP 

(Remote Desktop) Link and proceed to Step 4. The cloud portal can be accessed at portal.gigatrak.cloud 

REGISTRATION – (SELF-HOSTED ONLY) 

STEP 2  

The Registration Form will appear with pre-populated data. To use the system with a demo database 

(Access Only), register the information that pre-populates. If you were given a timed demo key or have 

purchased the system and received a license key in your Order Acknowledgement Email, copy and 

paste your license information over the top of the pre-populated information and register. Upon 

registering, the system will unlock the required features and licenses.  

If you have registered with an Access database a notification will ask if you would like to start with a 

clean database (no data) or continue with the data that is already in the system (demo database or any 

information you have entered in to the system). If you have immediately installed with a Sequel Server 

back-end, there is no demo database.  

CREATE A USER/LOGIN 

STEP 3  

Depending on your installation (Access vs. SQL), you will be asked to create a new user or login. If 

asked to login, you can use the following credentials 

Username: ADMIN 

Password: ADMINUSER 

Otherwise, create a user login for yourself. This user is automatically given Edit rights to all functions 

(except the Setup Options; only Admin has access to the Setup Options).  



Jul-24 TTS USER MANUAL 9 
 

ENTER EMPLOYEES 

STEP 4  

Go to File→Employee Administration to manually add in New Employees to the system. Press “Add”. 

Bolded fields are required. At a minimum, an employee will have First Name, Last Name and Barcode. 

The barcode field can be anything you like as long as it’s unique. If you already have some form of 

employee ID number or barcode, you should incorporate it here in the system. If not, you can make up 

a barcode (unique set of characters). We recommend between 4-7 characters for a barcode. The 

barcode will be used when performing a checkout to a Person.  

 

 

If the employee will be logging in to the system and performing transactions (on the PC or mobile app), 

they will need to be given a login name and password and have their access levels set on the right-

hand side. If the employee will not be logging in but you would like to check items out to them, only 

the bolded fields are required.  

 

Employee profiles are unlimited.  
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FACILITIES/LOCATIONS 

STEP 5  

After your employees have been entered, it is recommended you create your Facilities and Locations in 

the system. Go to Support→Facility Administration. Every single tool must have a facility and storage 

location (home location). You will not be able to enter new items without first creating these locations. 

Facilities and Locations have a Parent/Child relationship. For example, your House could be a Facility 

and all the rooms within your house are specific locations. If you have just a single company location (as 

many do), you might enter your company name as a Facility. If you have multiple locations, they will 

each be their own Facility. Examples of both are below (one facility vs many).  

 

If you plan on checking assets/tools out to jobsites, it is recommended that you create a fictitious 

facility called “Jobs” or “Jobsites”. This is not a real building, but it will be used as a placeholder to keep 

all your jobs separate in use with reporting. Another fake facility could be called “Customers”.  
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Next, we will create specific locations underneath each Facility. Go to Support→Location 

Administration. If you have entered multiple Facilities, use the drop-down menu to pick the Facility you 

wish to add a Location to. Click “Add”. Add in a Location name where your tools are stored. This can be 

a very general location like “Storage” or “Warehouse” or “Tool Crib”. The Location must also have a 

unique barcode. You can make up a barcode, put in a pre-printed barcode number or just put in the 

same thing as the Location name (example below). Mark this as a Storage Location. Address, 

Responsible Individual, and Notes are optional.  
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Or, you can choose to get more specific with your locations. For example, maybe you would like to 

know specifically where in the Warehouse an item is stored. In the example below, I have created many 

Storage Locations underneath the “GigaTrak New York Facility” such as aisles, bins, and shelves.  

 

You can have any many Storage Locations as you wish. Each time you enter in a new tool in the 

database, you will be asked for its Storage Location.  

If you plan on only checking out tools to employees, you are done with the Facilities/Locations.  

However, if you plan on checking out items to locations such as jobsites, you will need to create 

checkout/usage locations now.  
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In Support→Location Administration, using the Facility drop-down menu, pick the Jobs Facility or a 

Facility you have created. Press “Add”. Put in your job or location name and barcode (if you use job 

numbers or codes, you should use that as the barcode). This is where an item is being used (not stored) 

and therefore will be a Checkout/Usage Location.  

 

 

Please note this is only one example of checkout/usage locations. Every situation is different. You may 

be checking out to classrooms, suppliers, customers or work areas, etc. Also, this quick start guide does 

NOT cover Transfer Locations as they are seldomly used. If you are moving items from one person to 
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another or one location to another, it is considered a checkout to checkout; not a transfer. Please 

contact training@gigatrak.com to see is transfer is applicable in your situation.  

 

CLASSIFICATIONS/TYPES 

STEP 6  

Next, you need to create Classifications and Types for your tools (aka Categories and Sub-Categories). 

Classes and Types also have a Parent/Child relationship. Every single tool MUST have a Classification 

and Type. Classes and Types can also be referred to as Categories and Sub-Categories for your tools.  

Go to Support→Tool Support Administration. The first tab is for creating your Classifications 

(Categories) that your tools will be put in to. Remember, you are NOT yet entering real tools into the 

system yet; just creating Categories and Sub-Categories that your tools will get put in to. Just like 

Facilities and Locations, you can choose to get very general or very specific with your structuring. Press 

“Add” to add in a new Classification. Descriptions are optional. Below, I have a number of different 

Classifications. This example focuses on “Computer Equipment”,  

 

Press “Save”.  

mailto:training@gigatrak.com
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Next, go to the F2 (Type) tab to add in a sub-category within “Computer Equipment”. Below, I show a 

number of different ‘Types’ under ‘Computer Equipment’.  

 

Description, depreciation, and default due dates are all optional.  

Another example of Classifications and Types is going very general. In the below example, I only have 

one Classification called “Tools”.   
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Underneath the general Classification of Tools, I can create more specific types of Tools like Drills, 

Sawzall’s, Computers, Laptops, etc.  

 

Every customer has a different structure for their Classifications and Types. It is up to your company to 

decide on how specific or general you get with these. Remember, you are NOT adding real tools yet 

and will get to further describe the tool when you enter a specific item. Classifications and Types will 

be important filters for narrowing down your tools when you are looking for something specific. It is 

recommended that you discuss this structure internally as a group and graph them out on a piece of 

paper before adding them in to the system.  

ADD NEW TOOL 

STEP 7  

Click on the Tools icon and go to the F2 tab (Tool Information). Press “Add”. Use the drop-down menus 

to pick the Class, Type, Facility, and Storage Location for the Tool. You will also need to enter in a tool 

description and barcode. All other information is optional. Press Save. Continue this process for all 

tools. For similar tools, you can use the “Copy” function to copy an existing tool and simply change the 

barcode and optional serial number (as this should be unique to every tool).  

Example of an added Tool with the bare minimum information (bolded fields only), 
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Example of an added Tool with all information,  

 

Remember only bolded fields are required. Everything else is optional, supporting information. 
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CHECK TOOLS IN/OUT 

STEP 8  

To move Tools from their home Storage Location to a person OR a checkout/usage location, you will 

perform a checkout. Go to the Check In/Out icon. The first tab is for checking Tools out. Using a corded 

or Bluetooth USB Scanner, you will first scan the Employee or Location barcode you would like to 

check a tool out to. If you do not have a scanner, you can also enter the barcode manually with your 

keyboard or choose from the ‘ellipses’ look-up box. Next, scan, enter, or look-up the barcode of the 

tool(s) you would like to checkout. They will be added to the grid. Finally, press “Save” or “Save/Print”.  

 

 

To Check Tools back into their Home Storage Location, go to the F2 tab labeled “Check In by Tool”. 

Scan or enter the barcode of the tool(s) you would like to check back in. Press “Save” or “Save/Print”.  

 

Upon Check-in, when a tool is added to the grid, you have the ability to  double click on Condition, 

Facility, Storage Locations, and Status to update this information upon check-in. A check-in note can 

also be added by double clicking in the respective ‘Check-in Note’ box. However, if everything is 

staying the same, leave the information as is and press “Save”.  
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REPORTS 

STEP 9  

There are over 40 canned reports in the system that can be run at any time. The most important 

reports are the reports that have “Tool Assignment” in the title. Tool Assignment by Employee and 

Tool Assignment by Location are the most popular reports depending on if you are checking out to 

Employees or Location. This will only show Tools checked out at that exact moment.  

To see what Tools are in Storage and available for checkout, look for the last report on the list titled 

“Unassigned Tools by Storage Location”.  

All reports can be printed as a PDF, saved electronically, emailed via Outlook or exported straight to 

Excel. GigaTrak does not integrate with any other software. However, you can export all information 

and do data dumps into the systems if needed.  

 

You have now finished doing the bare minimum setup to add tools, check them in/out, and run 

reports. This completes the TTS Quick Start Guide. Please see the below User Manual for full details on 

the remainder of the system.  

 

 

For additional questions not covered in this guide, please see full user manual below or contact 

training@gigatrak.com,  support@gigatrak.com,  or call us at 262-657-5500. 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:training@gigatrak.com
mailto:support@gigatrak.com


Jul-24 TTS USER MANUAL 20 
 

The following User Manual goes more in depth with specific functions of the system and features.  

 

GETTING STARTED 

Upon opening the program, the screen at left will appear. You will be prompted to enter a User Name 

and Password. If it is the first time logging in, you will use the Admin 

User’s data: 

Username: ADMIN 

Password: ADMINUSER 

Other users may be added to the system after setup. After users are 

entered into the system, they should each log in under their own User 

Name and Password.  

 

REGISTRATION – (SKIP FOR CLOUD) 

After logging in as Admin, click File on the menu and select Registration Forms. This step is important 

because it assigns licensing rights to you. Entering the information will unlock the program for your 

licensed use.  

The Four Digit Customer Identifier and the 16 digit License Key 

will be provided by Gigatrak when the product is purchased. In 

the Registration forms, you will also find the Device and Web 

Portal registration forms. 

If you purchased a mobile app license, you will need to register 

that license key seprately.  

 

SETUP OPTIONS 
After registering your product, click File on the menu and select Setup Options. You must be logged in 

as the Admin in order to access 

the Setup Options.  

TOOL SETUP  

This option can be used to 

change the names of the 

parameters to fit your needs. 

This makes up the structure of 

the system. Cloud accounts will 

not have a section titled “Report 

Auto Email Setup” or Root Image 

Folders”.  
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Classification, Type, Facility, Location, Condition, Account and Funding Source are parameters 

tied to tools with drop-down menus created by each organization. Model Number, Serial 

Number, Miscellaneous, and Asset Number are free text fields. Master is an optional feature in 

the system where you can create Master Templates for commonly purchased tools to force 

consistency with data entry (often renamed to ‘Template’). Container is a type of tool that gets 

other tools checked out to it, and then moved together around as a whole (Jobox, Tool Box, Kit, 

Trailer, etc.). Each title field can be renamed to suit your needs. Changing a title field is a 

system wide change. It is not recommended to change the first 4 title fields (Class,Type, 

Facility,Location) as they have a parent/child relationship and can make the system structure 

confusing. Classification is often renamed to “Category” and Type to “Sub-Category”.  

If you would like to alter any of the names, type in the desired value and then click the OK button.  

Every tool has certain required fields when doing data entry. At a minimum, every tool in the system 

must have a Class, Type, Description, Storage Facility, Storage Location, In-Service Date, and Barcode. 

However, you can make any of the optional fields required in the setup options by marking each field as 

required. This is a system wide change and will be required for ALL tools (Binned items do not track 

Condition or Serial number even if required). This includes data entry on both the PC version and the 

mobile application.  

 

Report Logo - If you wish to attach your own company logo to the system so that it shows on reports 

and lists generated in the system, click on the … next to “Report Logo”. If you are cloud-hosted, you 

must first put your logo in your cloud file browser. If you are self-hosted, right click on your TTS 

shortcut, and press Open File Location. Paste your logo in this file location. Once you click on the … in 

the setup options, your logo will be available to click on and press “Ok”. Be sure to Save the Settings.  

 

On Prem Only - The root image folder is the default location for images that you wish to tie to a tool. If 

the image is in the default location, only the file name is required in the tool screen to identify the 

image.  

The Custom Report Folder is the location for custom report files. If a custom report is ordered, the report 

file should be placed in a folder, and the path to the folder should be set in this option.  

The Report Logo allows the display of a company logo on reports. You can select a .bmp, .gif, or .jpg file. 

To clear a logo after it is selected, click the “Select” button and click Cancel on the selection screen. 

Default Service Reminder Intervals (Pro and Contractor Edition only) can be set on this screen for 

reminders on when service comes due on a Tool. The nofication can be different depending on whether 

you are tracking the maintenance in Days, Hours or Miles. Setting the reminder interval in the Setup 

Options is a system wide setting for all Tools. However, upon entry of specific Maintenance Types in the 

Support tab, certain types of tools can have a different reminder interval than the default set here.  

Hours or Miles can also be renamed if you would like to track maintenance in a different way. For 

example, you could rename them to “Cycles, Count Hits, Spins, Usage” etc.  
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Report Auto Email Setup (self-hosted only) is used  for the automatic email of check-in and checkout 

reports when a transaction is performed through the PC version of the system and for setting up 

scheduled reports. This section must be filled out by your IT department in order for automamtic emails 

to be sent. This feature is also used to send group emails through the reports section. Highlighting a 

specific report name will show an “Email Report(s) button at the top if that report is able to be mass 

emailed. If the Auto Email section is setup, and a user presses this button while highlighted on a report, 

an email will be sent out to each user associated with that particular report. For example, if 50 users 

have Tools checked out and I would like to send a report to each user on what they have; I can easily 

press this button instead of emailing each person individually. Cloud accounts automatically have this 

option.  

 



Jul-24 TTS USER MANUAL 23 
 

 

APPLICATION SETTINGS  

File→Setup Options, second tab, Application Settings control various functions in the Tool Tracking 

application.  

SHOW DEPRECIATION/PREFERRED DECPRECIATION TYPE 

If Show Depreciation is checked, then the depreciation information will be visible on the Tool 

information screen. The Tool Depreciation Report will also be available on the Reports screen. If the 

checkbox is not checked, the depreciation information will not be visible and the depreciation reports 

will not be shown.  

 

 

The checkbox cannot be 

checked until you accept the 

disclaimer.  

After accepting the 

disclaimer, the Preferred 

Depreciation Type selection 

will be enabled. This will be 

the default selection when 

adding new tools on the 

Tool Information screen. 

You can change your 

Prefferred Type of 

Depreciation from the 

drop-down menu. Choosing 

a preffered type does not 

limit you to only using that 

type. You will be able to 

switch the type of 

depreciation per tool if 

needed.  
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ALLOW DELETE TOOL, DELETE AUDIT, & PURGE TOOL HISTORY 

If checked, then the Delete button will be displayed on the Tool Information (F2) screen, and the Purge 

History button will be displayed on the Tool History (F3) screen and the Member/Job History Screen 

(Contractor Edition only) allowing any user with Tool edit rights to delete tools in the system, delete 

history of Tools and delete Member/Job Information (Contractor Edition only). If the checkbox is not 

checked, the Delete button and the Purge buttons will not be displayed. Furthermore, under 

File→Purge History, any user with Tool Edit rights will be allowed to mass purge all tool history records 

in the system prior to a specific date. For example, if you have had the system for 20 years, and no 

longer want to hold on to records for the first 10 years, you can put in a date and the system will 

remove all history records on every tool prior to that date. This can help free up space and potentially 

allow the deleting of old locations that are no longer being used. Last, having this option on allows any 

user with Tool Edit rights to delete Tool Audit Reports in the Reports screen.  

AUTO-POPULATE TOOL OR FIND TABS 

When checked, the system will automatically display information when a Find screen is opened (Tools 

Screen F1 tab, Members screen F1 tab). If not checked, you must first click “Extract Data”  to view a 

listing. When this option is turned on, tool lists and member lists will auto populate all active tools and 

all members without first having to search for something. It is recommended that if you have a lot of 

tools or members, turning this option off can greatly reduce the load time of the screen.   

CASCADE MASTER/CATALOG CHANGES TO TOOLS 

This selection gives you the option to push any changes from the Master/Catalog function to each 

respective Tool assigned to the Master/Catalog Number. CAUTION: Changes to the Master/Catalog 

may RESET User-Defined data to the values set within the Master/Catalog. Example, if you have a 

Master Template/Catalog and would like to update the description, there is a potentially to push this 

updated description to all tools assigned to that Master in the system without having to change each 

tool individually.  

AUTO-GENERATE TOOL BARCODE 

This option creates a new barcode ID when adding new tools IF NO BARCODE is assigned. Use this 

option if you intend to design and print your own barcodes and you would like the system to pick a 

barcode for you. If you have chosen to use pre-printed barcodes or are switching from an existing 

system do not select this option. The system will always use the next barcode in sequential order of the 

last one used to auto-populate (it is recommended you manually enter the first barcode with the 

sequecne you would like to start at).  

DISPLAY EMPLOYEE BARCODES BEFORE NAMES  

This applies to several report selection filters and drop-down menus. If you view employees primarily 

by their names, leave this unchecked. If you prefer tracking employees by the Barcode ID, then check 

the checkbox.  
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DISPLAY LOCATION BARCODES BEFORE DESCRIPTIONS 

This applies to several report selection filters and drop-down menus. If you view locations primarily by 

their names, leave this unchecked. If you prefer tracking locations by the Barcode ID, then check the 

checkbox.  

DISPLAY ACCOUNT NUMBERS BEFORE DESCRIPTIONS 

This applies to several report selection filters and drop-down menus. If you view accounts primarily by 

their names, leave this unchecked. If you prefer tracking accounts by the Barcode ID, then check the 

checkbox.  

AUTO-CREATE REPAIR MAINTENANCE TYPE (PRO AND CONTRACTOR EDITION ONLY) 

This option type will insert a generic repair maintenance type anytime a new Classification and Type of 

tool is created.  A “Repair” maintenance type can be used when a Tool randomly breaks and needs a 

repair. It has no interval and never ‘Comes Due’, it is just there for when an item breaks. It is highly 

recommended to mark this box before any data entry.  

SHOW MAINTENANCE DUE REPORT AFTER LOG IN (PRO AND CONTRACTOR EDITION ONLY) 

By selecting this option, the system will automatically display the “Maintenance Due” report 

immediately following log in. 

SHOW BIN TOOLS BELOW REORDER POINT REPORT AFTER LOG IN 

By selecting this option, the system will automatically display the “Binned Tools Below Reorder Point” 

report immediately following log in.  

REQUIRE CHECK IN BEFORE ANOTHER CHECK OUT 

Checking this box will require a checked out tool to be checked back in to the storage location before it 

can be checked out again. Leaving this unchecked will allow a tool to be checked out again without 

being returned to the storage location. This is called a Checkout to Checkout and not a Transfer.  

SHOW TRANSFER 

This option can be activated if you would like to relocate tools from one Storage Facility/Location to 

another. Once you check this and click the OK button, the Transfer tab will appear on the toolbar. 

Please note that very few customers use the Transfer option as it’s meant for multiple facilities and 

requires the setup of Transfer Locations such as shipping and receiving docks.  

ALLOW DUPLICATE ASSET NUMBERS 

The Allow duplicate Asset Numbers gives the option to have multiple of the same Asset Number, but if 

selected, the Asset Number field cannot be used for check out/check in of a tool. The Asset Number 

field is often used as a back-up to the barcode. If your company already had some kind of unique 
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identifier for a Tool before implementing our system, it is recommended you use the Asset Number 

field if it is different than the barcode. If this option is off, all Asset numbers are required to be unique 

and can be used in place of the barcode for checking tools in and out.  

AUTO E-MAIL EMPLOYEE UPON CHECKOUT 

Selecting this option will automatically generate a Check Out report to be sent to an employee via email 

(Microsoft Outlook only). For self-hosetd systems, the Auto Email section on the first tab of the Setup 

Options must be filled out. For all customers, each employees email address must be listed in their 

profile.  Automatic Email Reports will only be sent out when transactions are performed through the PC 

interface.  

AUTO E-MAIL EMPLOYEE UPON CHECKIN 

Selecting this option will automatically generate a Check In report to be sent to an employee via email 

(Microsoft Outlook only). For self-hosetd systems, the Auto Email section on the first tab of the Setup 

Options must be filled out. For all customers, each employees email address must be listed in their 

profile.  Automatic Email Reports will only be sent out when transactions are performed through the PC 

interface. 

ALLOW TOOLS WITH LOST STATUS TO BE CHECKED OUT 

If checked, Tools marked with a ‘Lost’ status can be checked out. Upon checkout, the Tool will 

automatically switch the status back to ‘Active’ (does not notify the user). If left unchecked and a lost 

tool is checked out, the user will be prevented from performing the transaction as the tool is marked as 

“lost”. I this example, the user can then go manually switch it back to active.  

REQUIRE PURCHASE ORDER WHEN ADDING OR EDITING TOOLS 

If checked, the purchase order field will become required for adding in a new tool or performing edits 

to an existing tool.  

SHOW MAINTENANCE ON HANDHELD (PRO AND CONTRACTOR EDITION ONLY) 

This option allows maintenance records to be performed on tools when using the mobile application. 

Unchecking this box will remove the “Maintenance” button from the mobile app for all users.  

ENABLE MAINTENANCE HIERACHY  

The Maintenance Hierarchy feature allows users to set up different maintenance types in a hierarchy. 

Therefore, completing a higher level of the Maintenance will complete subsequent lower levels. See 

the Maintenance section of this user manual for more information.  

PROPMT TO PRINT MAINTENANCE REPORT WHEN SAVING MAINTENANCE 

If on, this option will prompt for printing a maintenance report when maintenance is saved at any 

point on the PC version of the system.  
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AUTO COMMIT DOWNLOADED DATA UPON SYNC (SELF-HOSTED ONLY) 

If checked, this option will result in the data from the handheld being automatically committed to the 

PC database upon docking the handheld. If unchecked, the process to sync & commit data will be 

“Sync”→ “Commit”→ “Sync”. This option is only for old Windows Mobile handheld units.  

SHOW BARCODE SEARCH ON DEVICE APPLICATION 

If checked, a search option will appear on the mobile app allowing users to choose a name or location 

from a look-up box. A magnifying glass icon will appear on a number of screens allowing users to look 

up barcodes and choose from a list of options.  

ALWAYS ALLOW CONDITION EDIT ON CHECK OUT/ CHECK IN 

If this option is turned on, users performing check in/out transactions will be able to change/update 

the condition on tool even if they have simple rights for check in/out and/or view only rights to Tools.  

PREFERRED DEPRECIATION TYPE 

If “Show Depreciation” is turned on, the ability to pick a preferred type of depreciation becomes 

available. Choosing a preferred type will automatically set each tool to this type of calculation. 

However, you can manually change a tools depreciation type if needed.  

FIND TOOL GRID AUTOSIZE MODE 

To change how the information is displayed on the F1 tab of the Tools icon, choose which option looks 

best depending on the information in your database. Single line may cut off information depending on 

much data is in that field. Auto sizing will display all information in each field and each row may appear 

a different size.  

LOG IN/ PASSWORD SETTINGS 

On the right side of the Application Settings box, there is an area for Log In /Password Settings. You can 

choose to Enforce Password Policy, by choosing a Minimum number of characters, Miminimum 

number of upper case characters, Minimum number of lower case characters, Minimum number of 

numeric characters, Minimum number of symbols, and Number of attempts before lockout (inactivates 

users).  Maximum password length is 20 characters. There is also the option to allow users to change 

their password. Selecting this option will give access for users within the system to change their own 

password under File-Change Password. If not selected, the Admin or anyone with Employee Edit rights 

will be the only one with authority to create or change a password for a specific user. To give users a 

defined number of attempted logins, enter a value in “Number of atetmpts before lockout”. Once a 

user hits this value, their login will be inactivated until an Admin or someone with Employee Edit rights 

manually changes their profile back to Active. Single sign on can can also be turned on from here. If 

single sign on is turned on, if the username (including domain) of the computer log in matches one in 

the system, that person will automatacilly be logged in upon opening the program. For cloud systems, 

the sign-on must match your RDP username to be auto logged in using this feature.  
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To save the changes for both tabs on the screen, select the OK button. A confirmation message will 

appear, listing the items that you altered. Selecting “Yes” will save the changes and close the screen. 

Selecting “No” will reset the changes back to the original values. To leave the screen without changing 

any values, select the     in the upper right corner of the screen. 

MEMBERS/JOBS SETUP (CONTRACTOR EDITION ONLY)  

The third tab of Setup Options creates members that you would check out tools to, or it could be used 

for jobs to which you check out tools. 

The Show Members checkbox will display the 

Member button on the main toolbar if 

checked.  If unchecked, the Member button 

will not be displayed. 

You can rename Member to whatever is 

appropriate for your company, such as 

“Contractor”.  There are 3 categories 

available to be used as needed.  Categories 

are searchable fields on the Member screen. 

There are 4 Additional Information fields that 

can be used as needed.  These are also searchable fields on the Member screen.  

To save the changes on all 3 tabs of the screen, select the OK button. A confirmation message will 

appear, listing the items that you altered. Selecting “Yes” will save the changes and close the screen. 

Selecting “No” will reset the changes back to the original values. 

To leave the screen without changing any values, select the  in the upper right corner of the screen. 

PRINTER ASSIGNMENT 

The printer assignment process is used to set the 

printer the system will use for barcode labels. For 

self-hosted systems, the system will automatically 

use the PC’s default printer to print lists and 

reports. For cloud-hosted systems, the user can 

choose which printer is to be used for lists and 

reports. Select Printer Assignment from the File 

menu and the screen below will be displayed. 

The Available Printers list will display all the 

printers that are on the Windows printer list.  

To select the label printer, select the printer of choice and then click the Assign Label Printer button. 

The Label Printer label will indicate the printer you selected. Any labels printed by the system will be 
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directed to this printer. If you do not have a label printer, assign the default printer to act as the label 

printer. 

 

TOOL CLASSIFICATIONS, TYPES, USER DEFINED FIELDS, AND MAINTENANCE  

This function allows you to create classifications and types. Classifications (i.e. Power Hand Tools) and 

their (sub-) Types (i.e. Drills, Saws, etc.) are used to categorize tools within the system. On the menu 

bar select Support→Tool Support Administration. You can rename the Class and Types designators in 

the system’s “Setup Options” function if desired. You can also add User Defined fields and Maintenance 

tasks to a specific type of tool. See Tool Support Administration in this Manual for more information.  

CONDITIONS  

This allows you to add any number of tool conditions that you desire (Excellent, Good, Poor, Needs 

Repair, etc.) This is a searchable field and can be valuable in locating equipment based upon their 

current condition. See the section on Condition Administration for more information.  

FUNDING SOURCE AND ACCOUNTS  

Funding Source and Accounts are standalone fields that can be set up to use as needed. These screens 

allow you to tie each tool to an account number or a funding source for added filtering. You can also 

rename the Funding Source and Account in the system’s “Setup Options” function, if desired. See 

Funding Source Administration and Account Administration for more information.  

MANUFACTURERS  

The Manufacturer is a standalone field that can be set up to help filter on equipment by manufacturer. 

See Manufacturer Administration for more information.  

FACILITIES  

This function allows you to enter facilities, which are used to organize tool locations. On the menu bar 

select Support→ Facility Administration. See Facility Administration in this Manual for a detailed 

explanation.  

LOCATIONS  

This function allows the user to create locations where tools are stored or to which tools are checked 

out. Locations can be classified as “Storage,” “Check Out/Usage,” or “Transfer” locations and are always 

tied to facilities. Storage locations are typically where materials are centrally located until checkout. On 

the menu bar select Support→Location Administration. See Location Administration in this Manual for 

a detailed explanation.  
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EMPLOYEES  

This function allows you to create users in TTS. A user may be an individual that will be using the TTS 

system, or a person to which tools may be checked out. You can also set TTS Access Rights for each 

user. On the menu bar select File→Employee Administration. See Employee Administration in this 

Manual for a detailed explanation. NOTE: The user must be logged in as “Admin” to access this option.  

MEMBERS (CONTRACTOR EDITION ONLY) 

This function allows you to create Members other than employees. A member is an individual to which 

tools may be checked out. You can set Member Categories in the Setup Options screen, and then add 

new members under the Members button.   

LABEL DESIGN  

The system allows the user to design labels for tools, locations, and employees. These labels typically 

have barcodes and can be used to audit, check in, and check out tools. Several sample label designs are 

included and can be modified. You must select a DEFAULT label design before printing is allowed. On 

the menu bar select Labels→Label Designer. See Label Designer in this Manual for a detailed 

explanation.  

TOOLS AND MASTER/CATALOG  

The tool administration screen allows for the creation of tools which are tracked by this system. On the 

main button bar select the Tools button. The Master/Catalog function is used to enter in common tools 

in a master/catalog data set that can be selected when adding tools – saving time and effort. See Tool 

Management in this Manual for a detailed explanation.  

 

 

Once you have setup your initial data, you are ready to start using TTS. Check out tools to employees or 

locations and create reservations. You can also check tools back “in” to storage. Be diligent on how you 

use the system, and it will provide years of reliable tracking of all of your tools!  

Backup your database daily! Cloud is backed up automatically by GigaTrak! 
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EMPLOYEE ADMINISTRATION 

Employees are either people that have access to 

the TTS system to do transactions, view tools, run 

reports, etc, or people whom tools will be 

assigned. To manage employees, select Employee 

Administration under the File menu. 

Upon initial setup, the only employee will be the 

Admin user. You may Add, Edit, or Delete 

employee information.  

To Add a new employee, select the Add button. 

The form will change as indicated. The items in 

bold text are required for all employees.  

The system will not allow editing of the last name, first name, middle initial, or user name for Admin 

User. The Admin password can be changed. If you are trying to login as the Admin but do not know the 

password, please call 262-657-5500 ext. 2 to get a daily password.  

To delete an employee, select the employee and then select the delete button.  

If an employee is assigned a tool or has an outstanding reservation or is involved in a history record, the 

system will not allow the employee to be deleted. Set the Status to inactive to prevent further use. 

To print employee labels, select the employee(s) to be printed and then select the Print Label button. If 

a label printer has been selected and if a default employee label has been designated (see Label 

Designer in this manual), the label(s) will be printed.  

For label printing, multiple employees may be selected. To select multiple employees, do one of the 

following:  

• Drag the mouse over the employees desired while holding down the left mouse button.  

• Select the first employee by left clicking with the mouse. Select the last employee in a range 

by holding down the Shift key and the left clicking on the last employee. All employees in 

between will be selected.  

• Hold down the Control (Ctrl) key and select the employees you wish to print by left clicking 

on each one with the mouse.  
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EMPLOYEE INFORMATION  

Enter the appropriate employee information. A few fields have 
special requirements:  
The barcode entry must be unique. A barcode for a tool, 

location, or employee cannot be the same. Keep the barcode as 

simple as possible, only using a short combination of capital 

letters and numbers. If you use the supplied barcode labels, the 

employee's barcode must match the label placed on their 

badge. Any employee barcode can be any set of unique 

characters. If you are making up an employee barcode, a first 

initial/last name is often used.  

 

If the employee will be using the TTS system (PC or app), he/she 

will require a Log in Name and Password.  

 

The Log in Name must be between 1 and 255 characters long. It 

must be unique; no two employees may have the same log in 

name. Log in names are not case sensitive.  

 

A password must be between 5 and 20 characters long. Passwords are not case sensitive. Password 

requirements can be set in the Setup Options.  

 

EMPLOYEE ACCESS LEVELS 

Once the employee information is entered, set the employee's access levels. The default access level is 

for no access to TTS. 

 

Master/Catalog/Template – applies to activities associated with creating, viewing and editing 

master/catalog data.  

 

Tools - applies to activities associated with creating, editing and viewing tool data.  
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Check In/Out – applies to activities associated with assigning tools to an individual, location, or 

container or returning tools to storage. Simple rights take away the users ability to lookup barcodes with 

the ellipses button on checkout as well as remove the F3 tab from the checkout screen 

 

Transfer – applies to activities associated with transferring tools within facilities (not often used) 

 

Reserve – applies to activities associated with creating, viewing and editing tool reservations  

 

Employee Administration – applies to activities associated with managing employee information 

including adding new profiles, viewing profiles and editing profiles  

 

Tool Status Administration – applies to activities associated with editing tool status from Active, 

Retired, Lost or Broken  

 

Support Administration – applies to activities listed in the Support drop-down menu. User can either 

add/edit/delete, view or have no access rights to this menu  

 

Maintenance Administration (Pro and Contractor Edition Only) – applies to activities associated with 

maintenance including adding in maintenance providers, creating maintenance repair types, performing 

maintenance transactions, and viewing maintenance history 

 

Members Administration (Contractor Edition Only) – applies to activities associated with the Members 

icon including the ability to add, edit, delete, and view member information 

 

Allow Clear Audit – Mark this option if the particular employee is allowed to clear audits on the 

Download/Audit icon 
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EMPLOYEE ASSIGNED FACILITY 

If you have multiple Locations/Facilities, 

you can select which ones an employee can 

check out/check in tools from and view 

tools within. You can check “All Facility(s)” 

to allow access to them all, or you can 

select individual facilities.  

Change the information or access levels as 

required and then select the Save button to 

save the changes, or the Cancel button to 

leave the Edit process without saving.  

If the user logged into the system only has 

view rights to employees, the Add, Edit, and Delete buttons will not be available. Instead, a View 

button will be available to allow the user to look at but not change employee information. 

 

OTHER FILE MENU FUNCTIONS 

BACKUP/COMPACT DATABASE  

If you have the Access version of TTS, this option is used to periodically repair, compact, and backup the 

TTS database. To determine if you have the Access version of TTS, go to the Help tab→About and the 

Database Type will say “Access” 

It is possible that the Access database can get corrupted. Compacting the database may repair the 

damage. In addition, a previous compact operation will have created a backup of the database that can 

be used if the current database is corrupted beyond repair.  

The system will retain three backup copies of the 

database in the dbbackup folder. Backing up frequently 

will minimize the loss of data if the current database is 

corrupted beyond repair.  

MS Access does not automatically remove data that is 

deleted by the system. Compacting the database will 

remove data that has been deleted. This will reduce the 

size of the database file and improve performance.  

To compact the database, select Compact Database under the File menu. Then select the Compact 

Database button.  
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The system will compact, repair, and backup the database and 

when complete, the Compact Database screen will disappear. 

CHANGE PASSWORD  

A user currently logged into TTS may change their password at any time. Select Change Password from 
the File menu and the screen at left appears. 
  
Type in your current user name and password and then select the Change password button.  
 
Passwords must be between 5 and 20 characters long. 
  

Type in your new password and then select the Change Password button.  

Type in your new password again. If the password matches the new 

password you typed earlier, the system will save the new password and 

the Change Password screen will disappear. 

If the password does not match the password typed in earlier, the system 

will state the passwords do not match and ask if you wish to try again. 

If you answer yes, the screen will be returned to the state above and you may try to type the second 

password again. 

LOGIN TEMPORARILY  

Log in temporarily is a function used in order to perform some function that the current user may not 

complete without the current user having to exit the program.  

 

Select Log In Temporarily under the file menu. The screen at right 

will appear. Enter your user name and password, and then select 

the Log In button.  

The banner on the main screen will turn red. As long as someone is 

temporarily logged into the system these conditions will remain.  

When the user temporarily logged in logs out by selecting the Log 

Out button, the main screen will return to normal and the original 

user is the current user.  

PURGE HISTORY  

If you would like to purge all history before a certain date, you can enter a specific date and then click 

OK. WARNING!! Be very careful with this feature, when you click OK, all tool history records (F3 tab of 

Tools) will be purged for good. This cannot be undone unless you have the option to restore to a 

previously backed-up copy of the database.  
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DEVICE ADMINISTRATION  

The Device Administration page allows you to select which devices have app licenses. This page can 

only be viewed when logged in as Admin.  

You may Activate, Inactivate or Delete 

Devices from the Device Administration 

page. To delete a device from the list, it 

will need to be inactivated first. Please 

note that once a device is inactivated you 

may not reactivate or delete it for 

another 24 hours. If an app user Registers 

their device without an Activation pin, 

they will need to be Activated on this 

screen in order to login and begin using 

the mobile app.  

 

 

HANDHELD CONFIGURATION  

The Handheld Configuration screen is used to 

select the handheld device. This version of TTS 

currently supports Windows Pocket PC and CE 

handhelds which is no longer used.  The TTS 

system has been updatd to now work with 

Android and iOS devices for mobility. 

To view the Handheld Configuration screen, click 

the File menu item and select Handheld 

Configuration. Android devices should check 

“Mobile Device”.  

IMPORTS  

Each import has specific instructions included on the import screen that delineates data formatting 

requirements along with any special instructions you may need. GigaTrak can also provide you with a 

Import Template for each of the items listed below. Columns with an asterisk on the template are 

required fields.  Imports are available for the following:  

 

Import Accounts: Allows the import of account data into the Account Administration table.  

Import Employees: Allows the import of employee data into the Employee Administration table. The 

import even allows for the granting of specific access rights to the various functions in TTS.  
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Import Employees(Active Directory): Allows the import of employee data into the Employee 

Administration table, based on Active Directory. All imported employees are set to a specific access 

levels based on an already created employee. This is not a live intregration. In order to update 

Employees with your AD path, the user must press the ‘Import’ button to update the system.  

Import Funding Sources: Allows the import of funding source data into the Funding Source 

Administration table.  

Import Locations: Allows the import of location data into the Location Administration function. Careful 

– Locations are Facility Specific so the data must be accurate.  

Import Maintenance History: Allows the import of past maintenance transactions to be imported per 

tool.  

Import Maintenance Providers: Allows the import of Maintenance/Repair providers. A 

Maintenance/Repair provider is required when recording a Maintenance Transaction.  

Import Manufacturers: Allows the import of funding source data into the Manufacturer Administration 

table.  

Import Master/Catalog Items: Allows the import of master/catalog data from outside sources. 

Additional data may be desired but requires user editing after the import is completed.  

Import Miles/Hours: Allows the import of a specific tools current mileage/hours (or if these fields are 

renamed in the setup options).  

Import Tool Documents: Allows the import of an unlimited number of attachments to a specific tool. 

(Default tool images are imported in the Tools import per tool).  

Import Tools: If you have spent years managing your inventory in an Excel formatted file, this can help 

you save time by importing your existing tool inventory quickly and safely. It is critical to ensure that 

the data is accurate and formatted properly to avoid bad data upon import!  

Import User Defined Data: Pro and Contractor Edition only. Allows the import of custom, user defined 

fields per tool. The tool must exisit in the database prior to import.  

Please contact GigaTrak directly to receive import templates and  specific directions regarding imports.  

TOOL SCREEN COLOR SELECTION  

The Tool Screen Color Selection screen allows you to set the 

color of the row and the highlight for tools that are coming due 

or are past due. This will re-color tools on the Find Tools tab if 

the tool has assigned a due date on checkout. The tool will flag 

as 'Coming Due' if the tool's due date is today or later. The tool 

will flag as 'Past Due' if the due date is yesterday or earlier. 

NOTE: This does not apply to items that are binned. 
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Set Coming Due Colors/Set Past Due Colors: Allows the options 

to select the color for the row and highlight color for the 

respective tool status.  

Selecting to change the color of the row or highlight for the tool 

status will bring up the color picker where you can choose the 

color you wish to have for the row or highlight. The Tool and 

Screen Color Selection screen will then display a sample of you 

chosen colors. 

 

LABEL MENU FUNCTIONS 

LABEL DESIGNER  

The Label Designer process is used to design labels for the various processes in the system that prints 

barcode labels. 

The processes that will print labels are: 

• Tools 

• Employee Administration 

• Location Administration 

These processes can be selected in the 

Design Type section of the form, which 

is located in the upper left corner.   

To design a label, first select the design 

type.  

 

The Data Source List will contain the possible fields that may be included in the label.  The list on the 

example contains the possible data sources for an Employee label. 

The Current Label Designs list will contain any labels that have already been created for the design type.  

The list currently contains a sample employee label.  When one of these labels is selected, the box on 

the right will display the label design, as indicated above for the sample employee label. 

To create a new label, select the Design type and then select New Design button.  Set the label size 

(Width and Height in inches).  Set the label orientation (Portrait or Landscape).  For Portrait, the height 

is vertical on the screen.  For Landscape the Height is Horizontal on the screen. 

There are 6 different elements that may be placed on the label.  They are from left to right: text, 

barcode, horizontal line, vertical line, box, and a graphic. 
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ADDING A TEXT ELEMENT 

Select the Text button in the Element Options panel.  Select (Label Caption only) in the Data Source box, 

and type a label caption in the Label Caption textbox.  You can select Wrap Text or Center.  To set the 

font style and size, click the Font button.  Click the Add to Label button.  The text element will appear in 

the upper left corner of the label design.  Drag it to the desired position on the label. 

To edit the text caption or font after a text element has been placed in a label design, right click on the 

element and choose the option desired. 

ADDING A DATABASE FIELD TEXT ELEMENT 

In the Data Source box, select the desired database field.  You can select Wrap Text or Center.  To set 

the font style and size, click the Font button.  Click the Add to Label button.  A sample of the data will 

appear in the upper left corner of the label design.  Drag it to the desired position on the label.  When 

the label is printed, the actual data for that field will be printed on the label. 

To edit the text caption or font after a database field text element has been placed in a label design, 

right click on the element and choose the option desired. 

ADDING A BARCODE ELEMENT 

Select the Barcode button in the Element Options panel.  Select (Label Caption only) in the Data Source 

box, and type a label caption in the Label Caption textbox.  You can select Center.  Select the barcode 

font and size desired.  Click the Add to Label button.  The text will be added to the label in the barcode 

font.  Drag it to the desired position on the label. 

If a database field is needed as a barcode, select the field from the Data Source box, and add it to the 

label.  When the label is printed, the actual data for that field will be printed on the label as a barcode. 

ADDING A HORIZONTAL LINE ELEMENT 

Select the Horizontal Line button in the Element Options panel.  Click the Add to Label button.  A 

horizontal line segment will be added to the label design in the upper left-hand corner.  Drag it to the 

desired position on the label.  To change the size of the line, place the mouse cursor over the right end 

of the line.  When the cursor changes to a double arrow, click and drag the endpoint to the desired 

length. 

ADDING A VERTICAL LINE ELEMENT 

Select the Vertical Line button in the Element Options panel.  Click the Add to Label button.  A vertical 

line segment will be added to the label design in the upper left-hand corner of the label.  Drag it to the 

desired position on the label.  To change the size of the line, place the mouse cursor over the bottom of 

the line.  When the cursor changes to a double arrow, click and drag the endpoint to the desired length. 

ADDING A BOX ELEMENT 

Select the Box button in the Element Options panel.  Click the Add to Label button.  A box will be added 

to the label design in the upper left-hand corner.  Drag it to the desired position on the label.  To 
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change the size of the box, place the mouse cursor over the lower right-hand corner of the box.  When 

the cursor changes to a double arrow, click and drag the endpoint to the desired size. 

ADDING A GRAPHIC ELEMENT 

Select the Graphic button in the Element Options panel.  Click the Find Graphic File button to find a file 

on your computer to place on the label.  File types supported are bmp, gif, jpg, wmf, and ico.  Click the 

Add to Label button.  The graphic will be added to the label design in the upper left-hand corner.  Drag 

it to the desired position on the label.   

Graphic elements are resizable.  Save the label design before attempting to resize a graphic element.  

Right click on the graphic in the label and select Resize Graphic.  A Resize Graphic box will appear above 

the Label Size box.  Enter the desired Height and Width (in inches) and click the OK button.  It may be 

possible to enter a size that causes the graphic to disappear from the label design.  If this happens, 

select a different label design.  When prompted to save changes, respond NO to the prompt.  Then go 

back to the label design and try again. 

DELETING A LABEL ELEMENT 

Select the element to be deleted from the label design.  Click the Delete Element button, or press the 

Delete key on the keyboard.  Elements can also be deleted by right-clicking on the element and 

selecting Delete from the popup menu. 

DELETING A LABEL DESIGN 

To delete an entire label design, select the design from the Current Label Designs list.  Click the Delete 

Design button at the bottom of the screen. 

SAVE AN EXISTING DESIGN AS A NEW DESIGN 

Time may be saved by copying an existing label design and modifying it.  Select the design from the 

Current Label Designs list, and click the Save Design As button at the bottom of the screen.  Enter a new 

design name and click the OK button.  Design names must be unique. 

VIEWING/PRINTING A LABEL 

The work space on the right-hand side of the screen provides a feel for how your label will print.  If you 

need to view exactly how your label will print, click on the View button with the Mode setting set to 

Design.  An exact replica of the label will appear.  To print the label on your label printer, change the 

Mode setting to Print, enter the number of labels you want to print and click the Print button. 

SAVE AS DEFAULT 

To save a label design as default for a specified process, select the Design Type (process), and select the 

label design from the Current Label Designs list.  Then select the Save as Default button. 

When a label is set as the default label, the word "Default" will appear after the label design. 
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LABEL QUICK START  

To put the tool barcode on your label as a barcode: 

a. In “Element Options” select the barcode button. 
b. In the “Data Source” list box, select “Tool Barcode”. 
c. Click the “Add to Label” button to put it in your label design. 
d. Drag the element to the desired position. 

To put the tool barcode on your label as a text field: 

1) In “Element Options” select the “T” button. 
2) In the “Data Source” list box, select “Tool Barcode”. 
3) Set the desired Font options. 
4) Click the “Add to Label” button to put it in your label design. 
5) Drag the element to the desired position. 

 

HELP MENU FUNCTIONS 

CHECK FOR UPDATE (SELF-HOSTED ONLY)  

After logging in, select Check for Update on the Help menu. Major updates may require you to contact 

GigaTrak and receive a special download. Access to the Check for Update function is only available 

when the ADMIN login is used.  You must have a current Support Agreement in place to download 

updates. Cloud contracts include all updates during your term.  

ABOUT  

The about page displays a lot of important information about your system including your version 

number, database Type, Customer Identification and the number of each type of license you have. 

CLOUD 

CLOUD FILE BROWSER  

The cloud menu will only appear for cloud-hosted systems. Click on Cloud→File Browser to open your 

cloud file storage. Each customer is provided with their own cloud storage for imports, exports, 

images, documents, etc. When importing or exporting data, you must go through the cloud file 

browser first. All exports (Excel, PDF, TXT) that are saved in the system will first be saved to the Cloud 

File Browser. To get that file locally, open the file browser and copy the file. Then, paste to your 

desktop. To import data, you must first copy your file to the cloud file browser. Then you will be able 

to grab that file for the import.  
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SUPPORT MENU FUNCTIONS 

ACCOUNT ADMINISTRATION (OPTIONAL)  

Account Administration is used to keep track of the account numbers that are used to purchase or 

assign tools to a specific account/department. Accounts will appear as a drop-down menu when adding 

in a new tool to assign it to one of the listed accounts. Accounts are optional and not required to use 

TTS.  

To begin the process, select Account Administration from the Support menu.  

To Add a new account, select the Add button. Enter the Account Number (required field) and a 

description (optional), then select the Save button.  

To Edit an Account, select the Account of interest and then select the Edit button. Modify the 

information as desired. Select the Save button to save the Account changes.  

To Delete an Account, select the Account to be deleted and then select the Delete button. The system 

will check to see if the account is tied to a tool. If so, the system will not allow the Account to be 

deleted. You may inactivate the Account to prevent it from being assigned to a tool in the future if you 

desire. The label of “Account” can be renamed in the Setup Options. For example, a user may choose to 

rename Accounts to Departments so the title field will now say “Department Administration”.  

CONDITION ADMINISTRATION (OPTIONAL)  

Tools may be assigned a Condition, which indicates the usefulness of the tool.  To access this process, 

select Condition Administration under the Support menu. 

Each Condition has a name and Description.  In addition, a Condition may be designated as Active or 

Inactive. Usage of Conditions is optional.  

Condition name may be up to 20 characters and is required.  This name must be unique.  

Description may be up to 80 characters long and is not 

required. 
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A Condition set as active may be assigned to a tool; a Condition set as inactive will not be available for 

assignment to a tool. Setting a condition as “inactive” minimizes clutter, but retains historical 

information tied to each condition.  

To add a new Condition, select the “add” button, 

enter the new Condition (name) and Description, 

and click “save” button to save the new 

condition. 

To edit an existing Condition, select the Condition 

to be edited and then select the Edit button.  

Modify the Condition (name), Description, or 

Status (Active vs. Inactive).  Select the Save 

button to save the changed Condition. 

To delete a Condition, select the Condition to be 

deleted and then select the Delete button.  The 

system will check to see if the Condition is 

assigned to a tool.  If so, the system will not allow 

the Condition to be deleted.  You may inactivate 

the Condition to prevent it from being assigned 

to future tools if you desire. 

FACILITY ADMINISTRATION (REQUIRED)  

Facilities are the upper hierarchy of locations.  In other words, locations are tied to a facility with a 

parent/child relationship.  Due to this structure, at least one facility is required by the system. 

To begin the process, select Facility Administration from the Support menu.   

To Add a new facility, select the Add button. 

Enter the facility information as desired:  

Facility Name: Up to 40 characters and is required.   

Address: Up to 40 characters, but it is not required. 

City: Up to 40 characters, but it is not required. 

State: Up to 2 characters, but it is not required. 

Zip Code: Up to 10 characters, but it is not required. 
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Notes: Up to 255 characters, but it is not required. 

Select the “Save” button to save the new Facility. 

To Edit a Facility, select the Facility of interest and then 

select the Edit button.  Modify the information as 

desired.  Select the Save button to save the Facility 

changes. 

To Delete a Facility, select the Facility to be deleted 

and then select the Delete button.  The system will 

check to see if a location is tied to the Facility.  If so, 

the system will not allow the Facility to be deleted.  

You may inactivate the Facility to prevent a location 

from being assigned to it in the future if you desire. 

(The title of “Facility” can be renamed in the back-end 

system Setup Options. However, it is important to 

remember that Facilities and Locations have a two-

step hierarchy and renaming may make the system 

confusing). 

FUNDING SOURCE ADMINISTRATION (OPTIONAL)  

Funding Source Administration is used to keep track of the agency, budget, or source that provided 

funding for the tool.   

To begin the process, select Funding Source Administration 

from the Support menu. 

To Add a new Funding Source, select the Add button.  Enter 

the funding source name, then select the Save button. 

To Edit a Funding Source, select the Funding Source of 

interest and then select the Edit button.  Modify the 

information as desired.  Select the Save button to save the 

Funding Source changes. A drop-down menu of current 

active Funding Sources will be available to assign to a tool 

upon entry.  

To Delete a Funding Source, select the Funding Source to be 

deleted and then select the Delete button.  The system will 

check to see if the Funding Source is tied to a tool.  If so, the 

system will not allow the Funding Source to be deleted.  You 

may inactivate the Funding Source to prevent it from being 

assigned in the future if you desire. The name of “Funding Source” can be renamed in the system 

Setup Options.  
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LOCATION ADMINISTRATION (AT LEAST 1 STORAGE LOCATION REQUIRED)  

Location Administration is used to manage the locations to which tools may be assigned.  It displays all 

the locations that exist in the system that are tied to the facility selected. Select File-Location 

Administration.  

To add a new Location, select the Facility to which it is to be added and then select the Add button. 

Enter the location information 

as desired:  

Facility - defaults to the facility 

selected on the main form but 

may be changed with the 

drop-down menu. 

Location - may be up to 50 

characters and is required.  

Must be unique to each 

location and is required.  

 

Barcode - may be up to 20 characters long and is required. A barcode for a tool, location, or employee 

cannot be the same. 

 

Checkout/Usage Location -location that tools can be checked out to. 

 

Storage Location - location used for storage rather than usage. 

 

Transfer Location (Rarely Used) - location that tools transfer to within a facility   

 

Responsible Individual – Optional. An employee that is responsible for the tools at the location. If the 

responsible individual is not in the system, you may go directly to the Employee Administration process 

by selecting the Add New Employee button. 

 

Notes – Optional. May be up to 255 characters long  
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Example of a Facility with one Location,  

 
 
Example of a Facility with many Locations,  

 

To edit a Location, select the Facility containing the Location, select the Location of interest and then 

select the Edit button.  Modify the information as desired.  Select the Save button to save the Location 

changes. 

To delete a Location, select the Location to be deleted and then select the Delete button.  The system 

will check to see if a tool is tied to the location or the Location is being used in a history record.  If so, 

the system will not allow the Location to be deleted.  You may inactivate the Location to prevent a tool 

from being assigned to the Location in the future if you desire. 
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EXPORT LIST TO FILE 

This button will export information for the displayed locations to a tab delimited text file. 

CHANGE RESPONSIBLE INDIVIDUAL 

Change Responsible Individual will change the responsible individual for all selected locations on the 

screen.  Display and select the locations that you want to change.  To select multiple locations, do one 

of the following: 

• Drag the mouse over the locations desired while holding down the left mouse button. 

• Select the first location by left clicking with the mouse.  Select the last location in a range by 

holding down the Shift key and then left clicking on the last location.  All locations in between 

will be selected. 

• Hold down the Control (Ctrl) key and select the locations you wish to change by left clicking on 

each one with the mouse. 

After the locations are selected, click the Change Responsible Individual button.  A screen will appear 

where you can select a new Employee.  Select the new Employee and click the OK button. 

PRINT BARCODE LIST 

Print Barcode List will print a list of the displayed location barcodes that can be used for scanning.  

When the Print Barcode List button is selected, a pop-up window will appear where you can set the 

barcode row height.  This allows you to control the space between barcodes on the list.  The minimum 

row height is 0.5 inch. 

PRINT LOCATION LABEL 

To print a Location label, select the location(s) to be printed and then select the Print Label button.  If a 

label printer has been selected and if a default location label has been designated (see Label Designer 

in this manual), the label(s) will be printed. 

For label printing, multiple locations may be selected.  To select multiple locations, do one of the 

following: 

• Drag the mouse over the locations desired while holding down the left mouse button. 

• Select the first location by left clicking with the mouse.  Select the last location in a range by 

holding down the Shift key and then left clicking on the last location.  All locations in between 

will be selected. 

• Hold down the Control (Ctrl) key and select the locations you wish to print by left clicking on 

each one with the mouse. 
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MAINTENANCE/REPAIR PROVIDER ADMINISTRATION (PRO AND CONTRACTOR 
EDITION ONLY)  

The Maintenance / Repair Provider screen allows you to standardize 

the name of each provider who services your equipment.  Select 

Maintenance/Repair Provider Administration on the Support menu. 

You can Add new provider names, edit the name, and delete those 

providers not already used for prior maintenance.  You can also 

inactivate a provider who is no longer on your list of approved 

maintenance providers. At least one repair provider must be entered in 

order to perform maintenance on your tools.  

 

 
 
 

TOOL SUPPORT ADMINISTRATION  

Support→Tool Support Administration is used to create Classifications and Types (aka Categories and 

Sub-Categories). Tool Support Administration screen has two (2) tabs:  Classification and Type.  

CLASSIFICATION (F1) 

The first tab is Classification.  Tools may 

be assigned a Classification (Category) to 

organize them in groups. 

Each Classification has a name 

(Classification) and Description (optional).  

In addition, a Classification may be 

designated as Active or Inactive. 

• Classification (name) may be up to 
20 characters and is required.  The 
Classification (name) must be 
unique (i.e., no other 
Classifications may have the same 
Classification (name)). 

• Description may be up to 80 characters long and is not required. 

• A Classification set as active may be assigned to a tool. 

• A Classification set as inactive will not be available for assignment to a tool. 

Setting a Classification to inactive reduces clutter in the system but retains historical information that is 

tied to that classification.  

To add a new Classification, select the Add button. 

1. Enter the new Classification (name) and Description (optional). 
2. Select the Save button to save the new Classification. 
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To edit an existing Classification, select the Classification to be edited from the listing and then select 

the Edit button. 

1. Modify the Classification (name), Description, or Status (Active vs. Inactive). 
2. Select the Save button to save the changed Classification. 

To delete a Classification, select the Classification to be deleted and then select the Delete button.  The 

system will check to see if the Classification is assigned to a tool.  If so, the system will not allow the 

Classification to be deleted.  You may inactivate the Classification to prevent it from being assigned to 

future tools if you desire.  

TYPE (F2) 

On the second tab of Tool Support Administration is Type (Sub-Category), which is a subclass of 

Classification.  Each Classification can have several Types.  In addition to grouping tools under a Type, 

the Type will also set the default depreciation period for tools assigned to it. 

Each Classification has one or more Types. 

Each Type has a name (Type), optional Description, and optional Depreciation period in years.   

A type may be designated as active or inactive. Set as inactive to reduce clutter & retain historical data 

tied to the type. 

• Type (name) may be up to 20 characters and is required.  The Type (name) must be unique (i.e., 
no other Types may have the same 
Type (name)). 

• Description may be up to 80 
characters long and is not required. 

• Depreciation may be up to 255 years 
and is not required. 

• Tools of this Type can be flagged as 
reservable by checking the 
checkbox.  This will make them 
available when using the 
Reservation function. 

• A Type set as active may be assigned 
to a tool. 

• A Type set as inactive will not be 
available for assignment to a tool. 

To add a new Type, select the Add button.   

1. Select the appropriate Classification for the new Type. 
2. Enter the new Type (name), Description, and depreciation period. 
3. Select if the type is reservable. 
4. Select the Save button to save the new Type. 

To edit an existing Type, select the Type to be edited and then select the Edit button.   

1. Modify the Type (name), Description, Depreciation, or Status (Active vs. Inactive). 
2. Select the Save button to save the changed Type. 
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To delete a type, select the Type to be deleted and then select the Delete button.  The system will 

check to see if the Type is assigned to a tool.  If so, the system will not allow the Type to be deleted.  

You may inactivate the type to prevent it from being assigned to future tools if you desire. 

 

Items of a certain type can also be assigned default due dates. This means that any tool designed to 

that type will be assigned an automatic due date upon checkout. Default due dates can be set as 

• End of current day at a specific time 

• Specific date and/or time (example: end of semester; end of job) 

• Number of days checked out (example: a tool can only be checked out for two days and then  

must be returned) 

If you are not planning on using due dates OR a tool will have a specific due date that differs upon 

checkout, then this should be marked as ‘None’.  

Please note that in order for default due dates to work, the PC version must have the “Apply Type Due 

Dates” box checked on the checkout screen and the mobile app must have the toggle of “Apply Type 

Due Dates” turned on as well. If these are off, due dates will not be applied.  

USER DEFINED FIELDS (F3) (PRO AND CONTRACTOR EDITION ONLY) 

The third tab under Support→Tool Support Administration is User Defined Fields. User Defined Fields 

(or custom fields) are optional and can be added specific to a tool “Type”.  When new tools are added 

to the system, the added fields are displayed in the Tool Information screen for user entry.  New UDF’s 

cannot be added on the F2 screen of the tool and must be added under Tool Support Administration.  

To add a new field, press “Add” and select the appropriate Classification and Type for the tool, a listing 

of the current User Defined Fields is displayed.  Enter the name of the custom field and press “Save”. 

Each field has a name and may be designated as Active or Inactive. 
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Setting a User Defined Field to inactive does 

NOT remove the data already recorded for 

any tool of that type.  It will not be displayed 

on the Tool Information screen.  Returning 

the tool to active will restore prior data for 

each tool of that type. 

 

• The Field Name may be up to 50 
characters and is required.   

• A Field Name set as active will be 
assigned to each tool of that Type. 

• A Field Name set as inactive will not 
be available. 

MAINTENANCE (F4) (PRO AND 
CONTRACTOR EDITION ONLY) 

The fourth tab of Tool Support Administration is Maintenance.  All scheduled maintenance 

(maintenance that comes due on an interval) must first be setup on this tab. Each “Type” of equipment 

may be assigned a group of specific Maintenance items with a preset interval in days, months, 

operating hours, or mileage for required performance.  In addition, a “Repair” maintenance item may 

automatically be inserted when a new “Type” is created.  The auto-create “Repair” setting is set in the 

Setup Options screen. 

Maintenance is tied to classes and types of tools. Each maintenance has a Description and Special 

Instructions. In addition, a maintenance item may be designated as Active or Inactive. Setting as 

inactive reduces clutter but retains historical information tied to the maintenance. 

• The Maintenance Description may be up to 50 
characters and is required.  The Description must 
be unique (i.e., no other Description may be the 
same). 

• Special Instructions may be up to 255 
characters long and is not required. 

• Interval is the length of time between 
performing the maintenance activity (i.e., do a 
Safety Inspection every 3 Months). 

• Service Reminder Interval will determine if the 
maintenance item is displayed on the 
“Maintenance Due Report”, which can be 
displayed after log in.  The setting for displaying 
the report is on the Setup Options screen. 

• The checkbox “Prevent Check Out/Transfer if Past Due”, if checked, will not allow the tools of 
this type to be checked out or transferred when the maintenance item is past due. 

• A Maintenance item set as active may be assigned to a tool of that type. 

• A Maintenance item set as inactive will not be available. 
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To add a new Maintenance Item, select the Add button. 

1. Enter the new Maintenance Description. 
2. Enter any Special Instructions. 
3. Select the Save button to save the new Maintenance Item. 

To edit an existing Maintenance Item, select the Maintenance Item to be edited and then select the 

Edit button.   

1. Modify the Maintenance Description, Special Instructions or Status (Active vs. Inactive). 
2. Select the Save button to save the changed Maintenance Item. 

To delete a Maintenance Item, select the Maintenance Item to be deleted and then select the Delete 

button.  The system will check to see if the Maintenance Item is assigned to a tool.  If so, the system will 

not allow the Maintenance Item to be deleted.  You may inactivate the Maintenance Item to prevent it 

from being assigned to future tools if you desire. 

SETUP MAINTENANCE HIERARCHY 

Maintenance hierarchy must first be turned on in the System Setup Options (File-Setup Options-

Application Settings-Enable Maintenance Hierarchy). Once turned on, it will appear on the F4 tab in 

Tool Support Administration.  

Press “Add” to create a new Maintenance Type. Select the Classification and Type the Maintenance 

will go under. Enter the Maintenance description, any special instructions (optional), the interval and 

the reminder interval.  
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To add a Maintenance Hierarchy, select a letter and hierarchy number for the Maintenance Type as 

well.  

Any Maintenance Types with the same hierarchy letter will complete other maintenance types with 

the same level but a higher number. For example,  

Oil Change – Letter A1 

Tire Rotation – Letter A2 

Mileage Check – Letter A3 

Therefore, completing “Oil Change” will complete all higher levels as well and reset their interval.  

If only A2 was completed, then A3 will complete as well but A1 will not.  

B and C Maintenance letters will not complete when completing A. Only Maintenance Types in the 

same letter category will be completed (higher numbers only).  

 

TOOL MASTER/CATALOG SCREEN  

The Tool Master/Template/Catalog Screen is used to ensure that like items are entered into TTS the 

exact same way.  This helps when searching for tools and items within your inventory.  The goal is to 

establish a standardized way of entering your equipment that utilizes a “Master/Catalog Number” to 

track each tool.  A Model Number can commonly be used as the Master/Catalog Number since it 

uniquely identifies the manufacturer and model being tracked.  This master/catalog list can also be 

called a Part Master, Item Master, Lot Number, or other common term.   

FIND MASTER/CATALOG (F1)  

The Master is an optional features that allows you to create Master Templates for your tools. This can 

be commonly purchased tools or tools that you have a lot of. The purpose of the Master is to create 

data consistency or standardized data entry. For example, if you have two employees entering new 

tools, one may call an iPad something different than another person may call it. They may also 

categorize it differently. To avoid this from happening, customers choose to create Master Templates 

that are then used to add in real tools with standardized data. Click on the Master icon. Two tabs are 

displayed.  There are no standard Masters in the system as each customer is different. The first is the 

“Find” tab allowing you to filter and view those items within the master/catalog by: 
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• Manufacturer 

• Classification 

• Type 

• Status 

• And a search by 
Master/Catalog 
Number, Description, 
or Model 

Several key aspects are 

available on the form.  As an 

example, selecting the Reset 

button will return all selections 

to All.  In addition, the 

Master/Catalog list can be 

sorted by one of its columns 

by clicking on the heading of that column.  A second click will reverse the sort order of the items in the 

listing. 

SEARCH FIELD 

Groups of master/catalog records can also be displayed by selecting Description in the Search Field 

dropdown list, typing words in the Search box, and then selecting the Extract Data button.  For 

example, type the word “drill” into the box and click Extract Data.  Only tools that have the word “drill” 

in the description will be displayed.  

ADD TO LIST 

The Add To List button can be used to build a custom list of Master Templates.  When selected, it will 

appear to remain depressed.  When in this mode, tools that are extracted will be added to the list of 

tools already shown on the screen, rather than clearing the screen first.  You can continue to change 

the selection filters and extract the tools you need to build your list.  The list can then be printed or 

exported.  Clicking the Add To List button a second time will return the Extract Data function to its 

normal mode. 

PRINT LIST 

To print the Tools in the list, select the Print List button.  .  A report is displayed and the Tools displayed 

on the screen will be printed when Print is selected.  You may also create a PDF or Email directly from 

the report. 

PRINT BARCODE LIST 

Print Barcode List will print a list of the displayed tool barcodes that can be used for scanning.  The list 

will include the Master/Catalog Number, Master/Catalog Barcode, Description, Model, and Status.  

When the Print Barcode List button is selected, a pop-up window will appear where you can set the 
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barcode row height.  This allows you to control the space between barcodes on the list.  The minimum 

row height is 0.5 inch. 

EXPORT LIST TO FILE 

Export List To File will export information for the displayed tools to a tab delimited text file. 

EXPORT GRID TO FILE 

Export Grid To File will export only the information displayed in the grid at the same of exporting to a 

tab delimited text file.  

MASTER/CATALOG INFORMATION (F2)  

Any highlighted Master/Catalog tool can then be viewed in the Master/Catalog Information by double-

clicking the record or selecting the tab. 

With selected fields included, you are able to standardize the parameters for the Master/Catalog tool 

item being entered.   

NOTE:  If you edit or change any information in the Master/Catalog Information, you will be prompted 

as below: 

Do you want to update all matching Tools’ data with the Master/Catalog Information? 

This could result in any custom changes to individual tools to be lost. 

This allows any change to be updated in every record tied specifically to this Master/Catalog Record. 

REMEMBER – You only need to add a specific model of tool ONCE in the master/catalog.  The COPY 

function just saves you time to create a similar record but still make appropriate changes to 

differentiate the tools. 
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TOOLS SCREEN 

The Tool management process is started by selecting the Tool icon on the main toolbar, which displays 

the screen below. The title fields on the table can be resized and rearranged as you like by dragging and 

dropping them to their desired position. The program will remember your changes to the size and 

arrangement locally. So, the next time someone runs the program on that machine the sizing and 

arrangement will be just as it was left by the last user. 

 

The Tool management form is composed of four tabs: 

• Find Tool 

• Tool Information 

• Tool History 

• Tool Maintenance (Pro and CE) 

 

FIND TOOL (F1)  

The first tab (F1 Find Tool) is mainly used to view tools, print a list of tools, and print tool labels.  The list 

of Tools on the 

screen is controlled 

by the multiple 

selections on the 

upper part of the 

form.  These 

selections are: 

• Facility 

• Location 

• Funding 
Source 

• Account 

• Manufacturer 

• Condition 

• Search (by barcode, asset number, description, in service date, model number, notes, and serial 
number, misc., due date, purchase order) 

• Master/Catalog Number 

• Classification 

• Type 

• Status 

• Other Search (Binned Tools, Consumable Only, Non-Consumable Only, Assigned to Employee 
Barcode, Assigned to Location Barcode, and Assigned to Container Barcode, Tools Checked In, 
Tools Checked Out, Reservable Tools, Supplier Look-Up, Maintenance Requests) 
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A listing of all active tools will appear if the “Auto Populate Tool Find Tab” option is turned on in the 

Setup Options. If this option is not turned on, the grid will be blank and the user will be forced to use 

the filters to search by specifics. Once they hit “Extract Data” a listing of tools that match the filters will 

appears. When Resetting, the grid will be blank again.  

All of these selections are administered under the support menu of the main form.  Each is tied to a 

tool in the Tool Information tab of this form.  Select the parameters of choice and then select the 

Extract Data button to change the tool display to match the filters. 

Several key aspects are available on the form.  As an example, selecting the Reset button will return all 

selections to All.  In addition, the Tool list can be sorted by one of its columns by clicking on the heading 

of that column.  A second click will reverse the sort order of the items in the listing. 

SHOW THUMBNAIL IMAGES 

If an image is assigned to a tool, a thumbnail picture will be 

displayed in the Description column of the grid.  The 

thumbnail display can be turned on or off by right-clicking in 

the grid and selecting “Show Thumbnail Images” in the 

popup menu. 

NOTE:  Some images may be incompatible with this 

application.  This can cause errors when data is extracted on the Find Tool tab.  If errors occur, find a 

tool that does not have an image (or add a new tool without an image) and display it in the grid.  Right-

click the item in the grid, and uncheck Thumbnail Images. 

A larger view of the image can be displayed by selecting “View Image” from the popup menu. 

SEARCH FIELD 

Groups of tools can also be displayed by typing words in the Search box, and then selecting the Extract 

Data button.  For example, select Description in the Search Field dropdown list, type the word ‘Chair’ 

into the Search box and click Extract Data.  Only tools that have the word chair in the description will be 

displayed.  If a Location is also selected, only tools that are located at that location and have the word 

chair in the description will be displayed. 

To find a specific Tool by its barcode: 

• Select Barcode on the Search Field drop-down list 

• Select the Barcode text box 

• Type in the barcode and select the Enter key on the keyboard, or scan the barcode with a wedge 
type barcode scanner attached to the PC 

• If the barcode matches that of a tool, the Tool will appear on the list 

ADD TO LIST 

The Add To List button can be used to build a custom list of tools.  When selected, it will appear to 

remain depressed.  When in this mode, tools that are extracted will be added to the list of tools already 

shown on the screen, rather than clearing the screen first.  You can continue to change the selection 
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filters and extract the tools you need to build your list.  The list can then be printed or exported.  

Clicking the Add To List button a second time will return the Extract Data function to its normal mode. 

CHANGE SELECTED TOOLS(S) 

The Change Selected Tool(s) function is used to change the Status of a group of tools all at once.  First, 

use the filters to display and select the tools that you want to change.  To select multiple Tools, do one 

of the following: 

• Drag the mouse over the Tools desired while holding down the left mouse button. 

• Select the first Tool by left clicking with the mouse.  Select the last Tool in a range by holding 
down the Shift key and then left clicking on the last Tool.  All Tools in between will be selected. 

• Hold down the Control (Ctrl) key and select the Tools you wish to change by left clicking on each 
one with the mouse. 

After the tools are selected, click the “Change Selected 

Tool(s)” button.  A pop-up will appear and you can select 

the option you would like to change.  Options including 

changing the  

• Status 

• Condition 

• Due Date (Tool must be checked out) 

• Storage Location 

CHANGE STORAGE LOCATION 

The Change Storage Location function is used to change the storage location of a group of tools all at 

once.  Display and select the tools that you want to change.  

To select multiple Tools, do one of the following: 

• Drag the mouse over the Tools desired while holding 
down the left mouse button. 

• Select the first Tool by left clicking with the mouse.  
Select the last Tool in a range by holding down the 
Shift key and then left clicking on the last Tool.  All 
Tools in between will be selected. 

• Hold down the Control (Ctrl) key and select the 
Tools you wish to change by left clicking on each 
one with the mouse. 

After the tools are selected, click the “Change Storage 

Location” button.  A screen will appear where you can select a new Facility and Storage Location.  

Select the new Facility and Storage Location and click the OK button. 

CHANGE CONDITION 

To change the Condition of a group of tools all at once, first sort and display the tools you want in the 

grid.  

• Drag the mouse over the Tools desired while holding down the left mouse button. 
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• Select the first Tool by left clicking with the mouse.  Select the last Tool in a range by holding 
down the Shift key and then left clicking on the last Tool.  All Tools in between will be selected. 

• Hold down the Control (Ctrl) key and select the Tools you wish to change by left clicking on each 
one with the mouse. 

After the tools are selected, click “Change Condition”. A screen will appear where you can select a new 

Condition for all tools highlighted. Select the new Condition and Press the OK button.  

 

CHANGE STATUS 

The Change Status function is used to change the Status of a group of tools all at once.  Display and 

select the tools that you want to change.  To select multiple 

Tools, do one of the following: 

• Drag the mouse over the Tools desired while holding 
down the left mouse button. 

• Select the first Tool by left clicking with the mouse.  
Select the last Tool in a range by holding down the 
Shift key and then left clicking on the last Tool.  All 
Tools in between will be selected. 

• Hold down the Control (Ctrl) key and select the 
Tools you wish to change by left clicking on each 
one with the mouse. 

After the tools are selected, click the “Change Status” 

button.  A screen will appear where you can select a new Status of “Active, Retired, Lost, Broken”.  

Select the new Status and click the OK button. 

CHANGE DUE DATE 

The Change Due Date function is used to change 

the due date of a group of tools that are currently 

checked out.  Display and select the tools that you 

want to change.  To select multiple Tools, do one 

of the following: 

• Drag the mouse over the Tools desired 
while holding down the left mouse button. 

• Select the first Tool by left clicking with 
the mouse.  Select the last Tool in a range 
by holding down the Shift key and then 
left clicking on the last Tool.  All Tools in 
between will be selected. 

• Hold down the Control (Ctrl) key and 
select the Tools you wish to change by left 
clicking on each one with the mouse. 
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After the tools are selected, click the “Change Due Date” button.  A screen will appear where you can 

select a new/updated Due Date with an optional time to be returned.  Click the “Ok” button to proceed 

or “Cancel & Exit” to reset with no changes. 

PRINT LIST 

To print the Tools that are currently displayed in the grid, select the Print List button.  A report is 

displayed and the Tools displayed on the screen will be printed when Print is selected.  You may also 

create a PDF or Email directly from the report. 

PRINT BARCODE LIST 

Print Barcode List will print a list of the displayed tool in the grid with a barcode that can be used for 

scanning.  The list will include the tool descriptions, model numbers, and serial numbers.  When the 

Print Barcode List button is selected, a pop-up window will appear where you can set the barcode row 

height.  This allows you to control the space between barcodes on the list.  The minimum row height is 

0.5 inch. Increasing the row height will space out the tool barcodes which makes scanning an item 

easier.  

PRINT TOOL LABEL 

To print tool labels: 

• Select one or more Tools in the list, 

• Select the Print Label button. 

For label printing, multiple Tools may be selected.  To select multiple Tools, do one of the following: 

• Drag the mouse over the Tools desired while holding down the left mouse button. 

• Select the first Tool by left clicking with the mouse.  Select the last Tool in a range by holding 
down the Shift key and then left clicking on the last Tool.  All Tools in between will be selected. 

• Hold down the Control (Ctrl) key and select the Tools you wish to print by left clicking on each 
one with the mouse. 
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COMPLETE MAINTENANCE 

A group of the same Type of tools can be completed for maintenance at a single time. For example, if I 

have 20 trucks that had an oil change, I can complete all 20 at once without having to go to each one 

individually and perform maintenance. This can only be 

completed on the same Type of tools with the same 

Maintenance assigned to each one. First, sort and highlight 

the tools in the grid.  

To select multiple Tools, do one of the following: 

• Drag the mouse over the Tools desired while holding 
down the left mouse button. 

• Select the first Tool by left clicking with the mouse.  
Select the last Tool in a range by holding down the 
Shift key and then left clicking on the last Tool.  All 
Tools in between will be selected. 

• Hold down the Control (Ctrl) key and select the Tools 
you wish to change by left clicking on each one with 
the mouse. 

Once the tools are listed, press the “Complete Maintenance” button. A pop-up screen will appear. The 

quantity of tools being completed in the bulk maintenance will be listed along with the Class/Type. 

Choose the start date, type, and provider and completed date. Cost is optional. Press “OK” or “Cancel” 

to clear the screen.  

EXPORT LIST TO FILE 

Export List to File will export information for the displayed tools to a tab delimited text file or an xls file. 

TOOL INFORMATION (F2)  

Selecting a tool and then selecting the Tool Information tab, or double-clicking on a tool, will bring up 

the Tool Information screen below.  

Tool information with bold text is required.  Many of the fields listed below are included in the sub-

tabbed section in the lower portion of the form.  The available tool information is: 
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• Master/Catalog Number is a 
selection to pull down general Tool 
information from the 
Master/Catalog screen 

• Classification is a method of 
grouping Tools 

• Type is a subset of Classification 
and a second method of grouping 
Tools 

• Description is up to 80 
characters describing the Tool 

• Facility is the building in which 
the Tool is located 

• Storage Location is the default 
storage location for the Tool 

• In Service Date is the date the tool was put into service (defaults to current date) 

• Barcode is the barcode that identifies the Tool.  You must enter the first tool’s barcode number 
manually in a format that all barcodes will use (i.e. A00001).  The system will then automatically 
increment the numerical portion of the barcode number one at a time. If you are using pre-printed 
barcodes, enter the number seen on the barcode.  

• Asset Number is the tools asset number, up to 30 characters 

• Condition is the physical condition of the Tool.  Condition does not apply to binned items. 

• Manufacturer is the manufacturer of the tool (data entered on the Manufacturer Administration 
screen) 

• Model is the model number of the Tool 

• Serial Number is the Serial Number of the Tool 

• Funding Source is the agency that provided the Tool  (User Definable Field) 

• Account is the account number used to purchase the Tool  

• Status.  An Active tool may be checked out, A Retired Tool may not be checked out. 
 
Only bolded fields are required for each tool entry.  

 

PRIMARY DATA SUB-TAB 

• Note is up to 255 characters of information about the Tool 

• Container allows other tools to be checked out to the container itself (i.e. tool box, gangbox, trailer) 

• Binned Item is used for small items that cannot be individually bar coded.  If the Binned Item 
checkbox is checked, an option will appear to mark the tool as a Consumable.  Boxes will also appear 
to enter a Storage Bin Quantity and a Reorder Point. 

• Check Out shows who or where the tool is checked out to (employee or location) 

• Due Date is the date the Tool is due to be checked in 

 

PURCHASE / WARR. SUB-TAB 

• Purchased From allows entry of general supplier information 
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• Warranty Expiration Date tracks when a warranty period expires 

• PO Num allows the entry of a Purchase Order related to the tool.  
o NOTE: PO Number will be required if it was marked required for adding or editing in the 

Setup Options menu.   

• Depreciation period in years (does not apply to bin items) 
o NOTE:  fields relating to Depreciation will not be visible unless the “Show Depreciation” 

checkbox is checked on the Setup Options screen. 

• Depreciation Type.  The system will calculate depreciation based on five methods: Standard Straight 
Line, MACRS Half-Year, MACRS Mid-Quarter, MACRS Double Declining Half Year, and MACRS Double 
Declining Mid Quarter 

o MACRS means Modified Accelerated Cost Recovery System 

• Original Value is the cost basis for depreciating the Tool 

• Salvage Value is the remaining value of the tool after it has been fully depreciated 

• Current Value is the current depreciated value of the Tool (calculated) 

• Date for Current Value is the date used to calculate the current value 

• Miscellaneous is a user definable field that can be used as desired 

 

IMAGES & DOCS SUB-TAB 

Tool Image is the path to a file that contains a picture of the tool.  If the image information is entered 
and a file is at the proper location, the picture will be displayed in the area to the right of the sub-tab 
section.  Double clicking on the image will display a full sized image of the picture.  In addition, linked 
documents, PDF, URLs, and other related files can be assigned to the Tool. 

USER DEFINED DATA SUB-TAB (PRO AND CONTRACTOR EDITION ONLY) 

User Defined Fields stores additional information specific to the type of Tool. User Defined Field names 
are first created under Support-Tool Support Administration – F3 tab.  

If a tool with user defined 

data is edited and the Type is 

changed, it is possible that 

duplicate user defined fields 

will appear.  This can happen 

if the new Type has the same 

user defined field names as 

the previous Type.  The new 

field will be blank and the old 

field will have data. 

To correct this, Edit the tool and enter the user defined data into the blank field.  Then blank out the 

data in the old field.  When the tool is Saved, a message will appear to indicate that user defined fields 

were found that do not belong to the selected Class and Type.  It will ask if you want to delete the 

fields.  Respond “Yes” to the prompt. 



Jul-24 TTS USER MANUAL 64 
 

MILES / HOURS SUB-TAB (PRO AND CONTRACTOR EDITION ONLY) 

Miles and Hours can be entered along with associated dates.  This is used in the Tool Maintenance 
section. 

BINNED AND CONSUMABLE ITEMS 

Binned and Consumable items must be selected at the time the tool is entered via the Add button.  Due 

to the different methods that bin and consumable data is tracked in the system, the Bin selection 

cannot be changed with the Edit function. 

Binned items are small items that would not be individually bar coded, such as screwdrivers.  They 

would be located in a common bin with a single barcode.  When they are checked out, they are 

expected to be returned. 

Consumable items are a subset of binned items.  Consumables are items that are checked out but not 

expected to be returned, such as gloves. 

Binned and Consumable items have a Reorder Point.  This is the minimum quantity that you want to 

keep in inventory.  When the Storage Bin Quantity reaches the Reorder Point, the item will appear on 

the “Bin Tools Below Reorder Point” report.   

ADDING A NEW TOOL 

To add a new Tool, select the Add button.  All information is cleared and the Save and Cancel buttons 

appear.  You can pre-enter in information by selecting a Master/Catalog Number or enter in all 

information without referencing the Master/Catalog Number.   

If turned on in System Setup Options, the system will automatically generate a unique barcode for the 

tool if the barcode field is blank.  If a specific barcode number is needed, just enter the number 

manually or scan with an attached scanner.  Each barcode number must be unique.  Select or enter the 

required information (bold fields).  Enter the non-required information if desired. Save the Tool by 

selecting the Save button.  The screen will return to the original state with the new Tool information. 

Cancel the process without saving by selecting the Cancel button.  The screen will return to the original 

state with the information displayed that was present prior to selecting the Add button. 

Additional drop-down menus can be added while on the F2 tab by clicking on “New” and typing over 

the word. Upon saving the record, the new field will be added to the drop-down menu moving forward. 

This works for all drop-down menus except Facility which must first be added in the Support tab.  

ADDING IN A NEW BINNED ITEM 

To add a new Binned Tool, select the Add button. Continue to fill out all required bolded fields like you 

would with a regular tool. BEFORE pressing Save, you must check the box marked “Binned Item” and 

choose whether it is a Non-Consumable Item (you expect to get it back) or a Consumable Item (you do 

not expect to get it back). Enter current Storage Quantity and Reorder point if necessary. Press Save. 
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Binned items are always tracked in quantities instead of individual meaning a group of items would 

share the same barcode. When this barcode is scanned for checkout, the system will ask the user how 

many they are taking.   

ADDING IN A CONTAINER 

A Container allows individually barcoded tools to be checked out to the container itself (i.e. tool box, 
gangbox, trailer) and moved around as a whole. To setup a new Container, click ADD on the F2 tab. 
Continue to fill out all required bolded fields for the Container as you would a regular tool. BEFORE 
pressing Save, you MUST mark the box labeled “Container” under the Primary Data Tab. Once the box 
is checked, press Save.  

EDITING AN EXISTING TOOL 

To edit an existing Tool, select the Edit button.  The Save and Cancel buttons appear. 

Change the Tool's information as desired.  Information with bold labels is required.  Save the Tool by 

selecting the Save button.  The screen will return to the original state with the changed Tool 

information. 

Cancel the process without saving by selecting the Cancel button.  The screen will return to the original 

state with the Tool information unchanged. 

COPYING AN EXISTING TOOL’S INFORMATION TO A NEW TOOL 

This is one of the most helpful features when multiples of the same type of tool needs to be entered.  

To Copy an existing Tool's information to use in creating a new tool, select the Copy button.  The 

majority of data is copied to a new record.  The exception is that the barcode number, serial number 

and checkout information is cleared and the Save and Cancel buttons appear.   

The system will automatically generate a unique barcode for the tool.  If this barcode is unacceptable, it 

can be typed over by the user.  The barcode entry must be unique.  A barcode for a tool, location, or 

employee cannot be the same.  Change the Tool's information as desired and add the new barcode.  

Save the Tool by selecting the Save button, the screen will return to the original state with the new Tool 

information. 

Cancel the process without saving by selecting the Cancel button.  The screen will return to the original 

state with the Tool information unchanged. 

To delete an existing Tool, select the Delete button.  After asking if you are sure, the system will delete 

the tool. The 'Allow delete tool and purge tools history' option must be set to on in order to have access 

to the delete button. 
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TOOL HISTORY (F3)  

Selecting a tool and then selecting 

the Tool History tab will bring up 

the Tool History screen. 

The screen displays the history of 

the selected tool for the date 

range selected.  The system 

defaults the date range to the last 

12 months.  Change one of the 

dates and select the Enter key or 

select a new date with one of the 

calendar controls and the list will 

change to reflect the new date range. 

A number of filters can be used to display only certain records. This includes: 

Check Ins 

Check Outs 

Tool Changes (such as barcode, status, condition) 

Storage Changes 

Audits (performed with the mobile app) 

Select the check box next to each filter and press “Apply Filters” to only get those search results in the 

grid.  

To print the history displayed on the screen, select the Print List button. 

To remove all history records prior to a specified date, enter the date in the Date text box and then 

select the Purge button.  All history records prior to the date specified will be deleted. The 'Allow delete 

tool and purge tools history' option must be set to on in order to have access to the purge button. 

TOOL MAINTENANCE (F4) (PRO AND CONTRACTOR EDITION ONLY)  

Selecting a tool and then selecting the Tool Maintenance tab will bring up the Maintenance 

Items/History screen below. Maintenance/Repair Types must first be setup under Support→Tool 

Support Administration→F4 tab.  
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The Maintenance Items tab lists 

the Maintenance/Repair Type(s) 

setup on the Tool Support 

Administration screen for 

specific Types of tools.  Special 

instructions, the interval 

required and the dates last done 

and due are shown.  If the type 

is due in the next 30-days it will 

be shown in blue.  Past due 

types are in red.   

 

Click on a Maintenance Type and press “Add” to record a maintenance transaction. The Start Date, 

Maintenance Type and Provider are all required fields.  If the item is being sent out but not yet 

complete, do not choose a Completed Date. Upon saving the record, the system will offer to print 

Maintenance Request form to send with the item to the provider (if turned on in the Setup Options).  

An “open” maintenance record is then inserted into Maintenance History.  When the item is returned, 

select the open record on the Maintenance History tab (second tab on the Tool Maintenance screen) by 

double-clicking the open line item.  Now enter the Completed Date along with optional Notes and a 

Repair Cost if appropriate.  Once saved, it is now a completed record in history. Items that are sent for 

maintenance without a completed date will automatically have a status change that says “Out For 

Maintenance”. When a tool is out for maintenance, it cannot be moved around. Upon completing the 

maintenance record, the status will automatically change back to Active.  

You can also perform a Maintenance Transaction by immediately choosing a completed date. This will 

still write a maintenance history record but the tool will not have the “out for maintenance” status.  

To print the history, select the Maintenance History tab and then select the Print Maintenance History 

button. 

To edit the history, click on the line item of the record to be edited and press “Edit”. Change any 

required fields and save.  

To attach an “Image/Doc” to a maintenance history record, first select the history record from the grid 

and press “Image/Doc”. If there is no image/doc currently tied to the record, the user will be asked if 

they would like to add one. Press “Yes” to attach an image/doc. The Image/Doc file path will appear 

and the user can select the desired file.  

Once the file has been selected, it is immediately attached to the history record. Pressing “Image/Doc” 

again will allow the user to either View the current image/doc or replace the one currently attached.  

MAINTENANCE REQUESTS 

The Maintenance Request feature allows users to Request Maintenance Line Items (along with Notes) 

without sending an item out for Maintenance. The benefit of this feature is that you are still able to 
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check tools out that have a Request on them (actually sending an item out for Maintenance does not 

allow a tool to be moved around). Once you perform a Maintenance Line item that has a Request on it, 

it will clear the Request out. Request Notes will show on the Maintenance History tab once the 

Maintenance has been started.  

 

You can request maintenance on tools that already have a maintenance type. The below example 

shows a truck that needs air in its tires as well as a new air filter. Because the truck can still be used 

(checked in/out) until these items are completed, I will use the Maintenance Request function to 

request work be done.  

 

First, highlight the tool you want to Request Maintenance on and go to the F4 tab. This truck has 4 

Maintenance types associated with it. You can only request Maintenance on Types that are already in 

the system (add additional Maintenance Types under Support→Tool Support Administration).  
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Click on the Maintenance Requests Button and press “Add”. Use the drop-down menu to choose the 

correct Maintenance Type you would like the request to go under. Enter an applicable Notes and press 

Save.  

 

 

 

You can enter as many Requests as there are Maintenance Types for a tool.  
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To add additional Repairs, you can either A. Edit the current repair and add additional Notes, or B. add 

additional Repair Types to a Tool.  

 

A.  

 

B. 

 

*Additional “Repair” Types added under Support → Tool Support Administration. 
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There are 3 ways to search Tools that have Requests. First, from the F1 tab, use the “Other Search 

Field” and choose “Maintenance Requests” from the drop-down menu and hit Extract Data.  

 

 

All Tools that have Requests on them will appear in the grid.  

 

You can also run a “Maintenance Requests” report. This will show any tools that have a Request, any 

Request Notes, and if the tool is currently checked out to a person/location/container.  

 

 

Last, you can print on a single tools Requests on the F4 tab in the “Maintenance Request” button.  
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Once you send an item out for Maintenance for a specific Maintenance Type, the Request will be 

cleared.  
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(Repair being completed that has a Request on it.) 

 

Maintenance History tab will list the Maintenance Line Item along with any Request Notes that may 

have been on it.  
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CHECK IN/CHECK OUT TOOLS SCREEN 

The Check Out process is used to check tools out to an employee or location.  The Check In process is 

used to check tools into storage from an employee or location.  Check Out and Check In can also be 

performed on the handheld unit.  To start these processes, select the Check In/Out button.   

CHECK OUT  

The Check In/Check Out process is composed of three (3) tabs.  The first tab is the Check Out process as 

shown below. 

To check out tools: 

• Select the radio dial option for the 

Container, Location, Employee or 

Member Category to which the tool will 

be checked out 

• If desired, enter the due date for the 

return of the Tool.  Enter a date in the 

Due Date box, or enter a Default Interval 

(number of days from today) 

• If desired enter any optional transaction 

notes 

• Scan or enter the Tool barcode in the 

Tool Barcode Field 

• If the Tool is a binned item, a box will appear below the barcode to enter the quantity being 

checked out 

 

The tool checkout information will be displayed in the grid.  To check out another tool to the same 

location/employee and with the same due date, scan or enter another tool barcode. 

If no scanner is available, you may enter the barcode information into the barcode text boxes and then 

press the enter key on the keyboard.  You may also select the find (…) button next to the textboxes to 

display a list to choose from. 

Items that are entered into the grid by mistake can be removed by selecting the item and clicking the 

Remove Item button. 

Once items are displayed in the grid, the Out Date/Time can be changed by clicking the Change Out 

Date/Time button.  A confirmation box will appear to indicate that the date/time will be changed for 

ALL items shown in the grid.  Responding “Yes” will display a calendar where you can select the desired 

date and time. 

When all desired tools have been checked out, select the Save or Save/Print button.  The check out 

information will be saved and, if Save/Print was selected, the system will ask if you wish to print the 

check-out report.  The system will then clear the check-out list. 
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To cancel the check-out process, select the Reset/Clear button.  After confirming you wish to reset the 

check-out process, the system will clear the check-out list without saving it. 

The column layout of the grid can be changed by dragging and dropping each column using the column 

title. This must be performed before tools are added to the grid.  

CHECK IN BY TOOL  

To check in an individual tool, select the Check In by Tool tab.  The screen will change as indicated 

below. 

To check a tool into storage, scan the 

tool barcode or enter the tool barcode 

and then press the Enter Key on the 

keyboard.  If the tool is a binned item, 

a box will appear to enter the quantity 

being checked in.  The check in 

information will be entered in the list.  

Condition, Facility, and Storage 

Location may be changed.  Select the 

column you wish to change, select the 

Enter key and pick the new Condition, 

Facility, or Storage Location from the 

list. 

If a consumable binned barcode is entered, a pop window will appear with all checkout transactions 

within the last month that have occurred with this barcode. Date filters can be changed to expand or 

condense the results listed in the grid. Choose the transaction you wish to return the consumables 

against by double clicking on it from the grid. The screen will return to the previous one and ask for the 

quantity being returned. Enter the quantity and press enter. Then press “Save” or “SAVE/PRINT”.  

 

Consumable binned items can also be added to inventory on this tab when new purchases occur. Enter 

the consumable barcode. A popup window will appear. Mark the radio dial labeled “Restock from 

Supplier” and press “OK”. Enter the quantity you purchased and press “OK”.  

 

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In 

Date/Time button.  A confirmation box will appear to indicate that the date/time will be changed for 

ALL items shown in the grid.  Responding “Yes” will display a calendar where you can select the desired 

date and time. 

When all tools have been checked in, select the Save or Save/Print button.  The check in information 

will be saved and, if Save/Print was selected, the system will ask if you wish to print the check in report.  

The system will then clear the check in list. 
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To cancel the check in process, select the Reset/Clear button.  After confirming you wish to reset the 

check in process, the system will clear the check in list without saving it. 

Check In can also be performed on the handheld unit. 

CHECK IN BY CONTAINER / PERSON / LOCATION /MEMBER  

To check in tools assigned to either a container, an employee or a location select the Check In by 

Container / Person / Location tab.  The screen will 

change as indicated below. 

To check a tool into storage, first select or scan the 

container, employee or location barcode the items 

are being returned from.  A listing of all items 

checked out to the container/employee/location 

will be displayed.  You can then click the check box 

for each line item being returned.  Binned item 

quantities can also be changed in the grid if desired. 

 

A Check All option box will check or uncheck all checkboxes for each line item listed.  Alternately, you 

can scan individual tool barcodes to check the checkbox.  You can also change the status to Lost or 

Broken for any items checked.  The change occurs on Save.  If someone returns multiple tools but has 

lost others, check-in the returned items first and Save.  Then, do a new check-in for the individual and 

confirm that the remaining items listed are lost.  Check All and Change Status to Lost then Save.  The 

COPY ROW function allows you to split up binned items being returned so that alternate locations can 

be assigned.  Verify the QUANTITY is correct before saving! 

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In 

Date/Time button.  A confirmation box will appear to indicate that the date/time will be changed for 

ALL items shown in the grid.  Responding “Yes” will display a calendar where you can select the desired 

date and time. 

When all tools have been checked in, select the Save or Save/Print button.  The check in information 

will be saved and, if Save/Print was selected the system will ask if you wish to print the check in report.  

The system will then clear the check in list. 

To cancel the check in process, select the Reset/Clear button.  After confirming you wish to reset the 

check in process, the system will clear the check in list without saving it. 

Check In can also be performed on the handheld unit. 
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TRANSFER TOOLS 
SCREEN 

Transferring Tools is a 

process used to relocate 

tools from one 

Facility/Location to 

another.  To start this 

process, select the 

Transfer Tools button.  

Keep in mind that only 

Facility/Locations 

designated as a Transfer 

Location on the Location 

Administration screen will be displayed in this form.   

Understanding the basic transfer process is important.  Just because an originating location transfers 

“Out” tools to a destination location does not mean that all of the tools arrive as intended.  To manage 

this process requires BOTH the sender and receiver to acknowledge the items being transferred.  If the 

sender lists ten (10) tools that they sent, but the receiver only acknowledges eight (8) tools – two (2) 

tools are now unaccounted for.  It becomes the responsibility of both parties to resolve the 

discrepancy.  The remaining two (2) tools will still be shown in the Transfer Out screen of the sender 

and must be reconciled at some point.  If lost, the best method to correct the problem is to: 

1. The sender selects the lost tools in the Cancel Transfer screen and saves the transaction.  The 
tools are now in the sender’s inventory. 

2. The sender then selects the individual record for each lost tool and changes the tool status to 
“Lost”.  Inventory is now accurate until the lost tools are found. 

TRANSFER OUT  

The Transfer Out process allows the user to select a Location Barcode that the selected tools will be 

transferred to.  Once a location is selected, the user then scans all of the tool barcodes being 

transferred.  You must enter the quantity being transferred for binned items.  CAUTION:  When 

transferring binned items, the system will try and match up barcode IDs based on the Master/Catalog 

ID of the item being transferred.  Adjustments to inventory may be necessary should IDs not match. 

CANCEL TRANSFER  

The Cancel Transfer process allows the sender to cancel items being sent, and returns them to 

inventory.  Select the Cancel Transfer tab on the Transfer form to proceed. 

To cancel a transfer, the user needs to first select the destination location where the tools were 

“Transferred Out” to.  It is important to note that only those inventory items not yet “Transferred In” by 

the receiving location will be listed.  The user only needs to check off the line items being cancelled and 

save the transaction. 
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TRANSFER IN  

 

The Transfer In process allows the 

receiver to acknowledge receipt of 

transferred items being sent to their 

inventory.  If all items are receipted, just 

select Check All and Save.  If you desire to 

change the receipted location, select the 

Change Location dropdown.  Any checked 

items will be relocated to the designated 

location upon Save. 

 

 

RESERVING TOOLS SCREEN 

Reserving Tools is a process used to reserve the use of a tool for a specified period of time.  To start this 

process, select the Reserve button.  The screen below will be displayed. 

FIND RESERVATIONS  

The Reserving Tools process is composed of two (2) tabs.  The first tab is the Find Reservations process.  

This is used to find the current reservations for a tool or employee/location. 

To view the reservations for a User/Location, scan the User/Location barcode into the User/Location 

Barcode textbox and 

the reservations for 

the User/Location in 

the date range 

specified will be 

listed. 

To view the 

reservations for a 

tool, scan the Tool 

barcode into the Tool 

Barcode text box and 

the reservations for 

the Tool in the date 

range specified will be 

listed. 
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If no scanner is available, you may also enter the barcode in the barcode text boxes followed by 

pressing the Enter key on the keyboard.  Another option is to select one of the find buttons, to display a 

list from which you may select.  

To change the date range for the reservation list, enter a new date and then select the Enter key or set 

the date using the calendar control.  The list will change to reflect the new date range. 

RESERVATION ADMIN  

The second tab is the Reservation Admin process.  The Reservation Admin process is used to add new 

reservations and edit or delete existing reservations. 

To add a new reservation: 

• Select the Reservation Admin tab, 

• Select the Add button, the screen changes as indicated. 

• Scan the Location or Employee barcode or select the Find button. 

• Scan the Tool barcode or select the tool. 

• Set the date and time range for the reservation. 

• Select a Priority.  High Priority items cannot be checked-out to any person or location except the 
one holding the reservation.  Low/Medium Priority settings alert the person checking out the 
tool if it is to a different location/user than the one holding the reservation. 

• If you desire, add a note and set the priority, then select the Save button. 

 

To edit an existing reservation: 

• Find the reservation in the Find 
Reservation tab, 

• Select the Reservation of 
interest, 

• Select the Reservation Admin 
tab, 

• Select the Edit button, 

• Modify the information as 
desired,  

• Save the reservation. 
 

 

To delete an existing reservation: 

• Find the reservation in the Find Reservation tab, 

• Select the Reservation Admin tab, 

• Select the Delete button. 

After verifying the deletion, the system will delete the reservation. 
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REPORTS SCREEN 

Each report has a different set of Report Filters that the user can select to create the report results they 

desire. 
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When the filters are set, the user then selects the Print Report button. A print preview screen will be 

displayed from which the report may be printed, saved as a PDF or Email(ed) (only if Microsoft Outlook 

is used).  Furthermore, all reports can be exported directly to Excel.  

 

AUTO E-MAIL REPORTS  

Several reports (Tool Assignment by Employee, Tool History by Employee, Tool Value by Employee, etc) 

give you the ability to Auto E-Mail the report when desired. Select “Email Report(s)” so that each 

person gets their own email with their information. Only employees with an email address record will 

receive their email report. Please note that self-hosted customers must have their SMTP Host 

information entered in the Setup Options for this feature to work.  

SCHEDULED REPORTS  

All reports can be scheduled to automatically be sent out at a certain date/time to a selected group of 

email addresses in either PDF or Excel format. First, a designated computer must be assigned as 

responsible for running scheduled reports at their scheduled time. Go to File-Setup Scheduled Reports. 

Press “Assign” and the current PC/Windows Login will now be used to send out scheduled reports. This 
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PC/Windows login MUST be logged in at any time a report 

is scheduled to be sent out. The profile of the person 

logged in to the TTS System at the time does not matter.  

Please note that self-hosted customers must have their 

SMTP Host information filled out in the Setup Options in 

order for reports to be scheduled and sent out.  

 

 

 

 

 

To schedule a report, go to the Reports icon. Highlight a report by clicking on it and choose the specific 

report filters you wish to have. Click on “Schedule Report”. Choose the frequency the report should be 

sent out and the Recipients of the scheduled report. If the report has date filters, you can choose to run 

the report with the date filters you have chosen or “Relative to Today”. This will always update the 

scheduled report to include all items up to today’s date.  

Determined by Report: Employee reports will only be sent to each employee individually if they are 

listed on the report. Employee must have an email address listed in their profile.  

Email: One or more email addresses can be entered using a comma to separate.  

Choose the format of the report to be either PDF or Excel (cannot do both). Scheduled reports can be 

sent to Inactivate to pause sending.  

When the time of the scheduled report arrives, a popup will appear on the assigned PC with a 30 

second count down. Once the timer reaches zero, the assigned PC will freeze until all reports have been 

sent. This may take several minutes or more. To bypass the count down, press “Run Scheduled 

Report(s) Now”. If a user is in the middle of a task, they can also choose to “Snooze” the schedule 

report(s) for a predetermined amount of time using the drop-down menu. The assigned PC cannot do 

any transactions while scheduled reports are being sent out.  
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If the assigned PC is not logged in at the time a scheduled report is due to go out, the system will send 

all past due scheduled reports the next time the assigned user logs in to the system.  

 

To view a list of all scheduled reports and their log history, click on 

“Scheduled Reports” in the Reports icon.  

 

 

The first tab will list all active and inactivate scheduled reports as well as the last result of the report 

being sent out. Click on and highlight a report and go to the second tab (log) to see the log results of 

the report being sent out via the schedule. Users can also view log history with specific date filters and 

purge log history if need be.  

 

 

To Edit a Scheduled Report, highlight it from the grid and press “Edit”. Scheduled reports can also be 

deleted. Deleting a scheduled report does not delete any data in the system.  
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CUSTOM REPORTS  

If desired, Gigatrak can provide custom reports at your request. These reports will be quoted separately 

and automatically added to the Select Report listing when installed.  

 

MEMBERS/JOBS SCREEN (CONTRACTOR EDITION ONLY) 

MEMBERS/JOBS  

FIND MEMBER/JOB 

The ‘Find Member/Job’ tab 

resembles the ‘Find Tools’ tab in 

the Tools screen. The first tab is 

used to view members/jobs, print 

a list of member/jobs, and print 

member/job labels.  The list of 

members/jobs on the screen is 

controlled by the multiple 

selections on the upper part of the 

form. 

Several key aspects are available on the form.  As an example, selecting the Reset button will return all 

selections to All.  In addition, the Member/job list can be sorted by one of its columns by clicking on the 

heading of that column.  A second click will reverse the sort order of the items in the listing. The Include 

Employees check box adds the employees to the data when it is extracted and makes the history 

viewable for the employees. 

MEMBER/JOB INFORMATION  

The ‘Member/Job Information’ tab resembles the ‘Tool Information’ tab in the Tools screen. The 

second tab is used to add, edit, 

and delete information on various 

members/jobs in the system.  

Member/Job Information that is 

bolded is required.  

Users can also print information 

regarding each member/job in 

the system.  

The information in these screens 

will be either member-related or 
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job-related depending upon which option is selected in the “Setup Options” screen. The information 

will carry over from one function to the other.  

MEMBER/JOB HISTORY  

Selecting a Member/Job and then selecting the Member/Job History tab will bring up the Member/Job 

History screen below. 

The screen displays the history of the 

selected member for the date range 

selected.  The system defaults the date 

range to the last 12 months.  Change 

one of the dates and select the Enter 

key or select a new date with one of 

the calendar controls and the list will 

change to reflect the new date range. 

To print the history displayed on the 

screen, select the Print List button. 

To remove all history records prior to a specified date, enter the date in the Date text box and then 
select the Purge button.  All history records prior to the date specified will be deleted for that 

member/job.  The 'Allow delete tool and purge tools history' option must be set to on in order to have 

access to the purge button. 

 

 

 

 

 

 

 

 

 

 

 

 

      If you have any questions, please contact support@gigatrak.com or call 262-657-5500 ext. 2 

 

mailto:support@gigatrak.com

